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FiberPatrol, Senstar and the Senstar logo are registered trademarks, and Silver Network is a trademark of Senstar Corporation. 
Product names and Company names included in this document are used only for identification purposes and are the property 
of, and may be trademarks of, their respective owners. Copyright © 2017, 2016, Senstar Corporation, all rights reserved. 
Printed in Canada.

The information provided in this guide has been prepared by Senstar Corporation to the best of its ability. Senstar Corporation is 
not responsible for any damage or accidents that may occur due to errors or omissions in this guide. Senstar Corporation is not 
liable for any damages, or incidental consequences, arising from the use of, or the inability to use, the software and equipment 
described in this guide. Senstar Corporation is not responsible for any damage or accidents that may occur due to information 
about items of equipment or components manufactured by other companies. Features and specifications are subject to change 
without notice.

Any changes or modifications to the software or equipment that are not expressly approved by Senstar Corporation void the 
manufacturer’s warranty, and could void the user’s authority to operate the equipment.

The figures included in this document are for illustration purposes only, and may differ from the actual equipment.

Compliance

The use of shielded cables is required for compliance.

Canada: This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

USA: This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device 
may not cause harmful interference, and (2) this device must accept any interference received, including any interference that 
may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the 
FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to 
correct the interference at his own expense.

Europe: 

CE: EC Low Voltage Directive 2006/95/EC

Service statement - We ensure that our products are correctly applied to achieve the maximum benefits for the end-user. We 
work hand-in-hand with our customers and remain accessible through all stages of a project - from concept to deployment to 
long-term support. We provide design assistance, site surveys, installation support, comprehensive documentation, training, 
post-installation annual calibration and maintenance visits, electronics and software extended warranty, rapid factory repair 
service and on-call/emergency service.
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1 IDS software environment

FiberPatrol processor
The FiberPatrol sensor unit (SU) uses the Windows 10 pro 64-bit operating system. The SU 
comes with the FiberPatrol Intrusion Detection System (IDS) software and software license 
installed. The FiberPatrol documentation is available on a USB thumb-drive. 

Figure 1 FiberPatrol processor & controller

Front/Side view

Rear view

Controller 

Processor

Processor

Controller 
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When the processor is started, it automatically logs onto Windows. The Windows start menu 
includes an application (Launch FiberPatrol.exe) that auto starts the FiberPatrol IDS software 
when the processor is powered up. Launch FiberPatrol.exe also monitors the processor and will 
restart the FiberPatrol IDS software when it detects that the program is not running. User access 
to the processor is via the keyboard monitor mouse unit in the head end equipment rack.

When the processor starts, the Launch FiberPatrol popup displays and counts down while the 
FiberPatrol IDS software initializes. To stop the initialization process and prevent the FiberPatrol 
IDS software from starting, select the X in the top corner of the popup during the countdown. To 
restart the FiberPatrol software, select the FiberPatrol icon  on the desktop.

To login to the Windows operating system, use the following credentials 

There are three access levels for the FiberPatrol IDS software, Operator, Supervisor and Installer:

Operator access level

The Operator’s function in the FiberPatrol IDS software is alarm processing. The Operator level 
provides access to the Alarms tab and the Alarm History tab. 

Supervisor access level

The Supervisor’s access level enables password maintenance, detection parameter adjustments, 
alarm zone setup, alarm display, alarm reporting, alarm simulations and tests. The Supervisor 
level provides access to the Alarms tab, the Alarm History tab, the Signal tab and the Log tab.

Installer access level

All initial configuration and setup procedures require the Installer access level. The Installer level 
provides access to all of the sub-menus including the System tab, which is unavailable to the other 
access levels.

Computer Name FiberPatrol-xxxx

Windows User Name FiberPatrol

Windows User Password xxxx

Note xxxx = the last four digits of the processor’s serial number.
FiberPatrol recommends changing the default Windows login 
settings. 

Note The default FiberPatrol passwords are provided during the system 
training session.

Note The configuration settings should be adjusted only by a factory 
trained technician.
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2 Configuration & calibration

Before setting up and calibrating the FiberPatrol sensor, the installer must ensure the following 
steps have been completed:

• all outdoor components are installed and tested

• OTDR testing of sensor cable completed successfully

• lead cable, sensor cable, fusion splices, end modules

• all indoor components are installed and connected

• indoor components powered up and operational (system software running)

Initial software configuration 

The FiberPatrol processor is configured for a DHCP network connection. The Windows Live 
Update feature is disabled. The FiberPatrol software and software license are factory installed, 
and the FiberPatrol software will auto-start when the processor is powered up. Once the 
FiberPatrol software is running, it will restart automatically if it is shut down by the user. When 
FiberPatrol is starting, a window displays to indicate the time remaining until the software is 
launched. 

Note The screen-shots included in this document are taken from the FP1100X 
Series sensor. For instances where there are significant differences 
between the FP1100X and the FP1400 windows, either screen-shots of 
both systems will be shown, or a note will be included to explain the 
differences.

Note The configuration setup and calibration procedures in this section require 
the Installer access level.

Note When the FP1400 system is run under the Installer access level, it shuts 
down automatically at midnight.

Figure 2 Launch FiberPatrol window

select the X button to cancel the Launch process
(app. 60 seconds to start-up)
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Once the launch countdown is completed, a Login window displays:

The System Status panel will display “Initializing” which will turn to Disarmed, Warning, or Cable 
Cut once the initialization sequence is complete. Ignore the System Status at this time as the 
FiberPatrol system has not been configured.

When first started, the processor loads a default Alarm Screen configuration with a straight line 
perimeter, in which the cable length is based on the license limit and a Cable Cut warning may be 
displayed if the installed cable length is less than the software license indicates.   

Figure 3 FiberPatrol login window

Figure 4 FiberPatrol System Status panel during initial startup

Note The Alarm Details for the FP1400 sensor does not include the Type, 
Location, Latitude, or Longitude columns.

Note The Installer access level Log sub-panel for the FP1400 sensor 
includes Location information that is required for location calibration.

Note Some of the following procedures apply only to one type of FiberPatrol 
configuration (e.g., loop). Verify that a procedure applies to your 
FiberPatrol configuration before attempting the procedure.
Refer to the FiberPatrol Site Planning and Installation Guide 
(FPDA0102) for information on the different configurations.

Username (not required)

enter Password

select the level of access

NOTE: contact the system supervisor for login 

(configuration and setup procedures
 require the Installer access Level)

            details 

Initializing Warning
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FiberPatrol sensor cable configurations

Figure 6 illustrates the most common FiberPatrol sensor cable configurations. Refer to Chapter 2 
in the FiberPatrol Site Planning and Installation Guide (FPDA0802) for additional sensor cable 
configurations and installation details. 

• For Loop configurations, Sensor 1 and Sensor 2 run in opposite directions around the 
perimeter, and back to the start point. There are two types of Loop configurations:

Figure 5 FiberPatrol default Alarm screen (installer access level)

Figure 6 FiberPatrol sensor cable configurations

Alarm processing buttons

Menu selection bar
Sub-panel tabs

Perimeter map display

Alarm data display fields

Status fields

sensor unit icon

0 m point

licensed length to end point
detected cable cut

(installed length of sensor cable)

temporarily, change the
Disturbance Life and the
Event Life to 10 seconds

set the period that the temporary
settings will remain active

apply the temporary settings

interrupted loop fully closed loop

line

split
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• The Fully Closed Loop - the two sensors cover the entire perimeter beginning and ending 
at the same location (with or without start point splice). 

• The Interrupted Loop - the two sensors do not fully cover the entire perimeter having 
different start and/or end points, typically to accommodate a building or structure.

• For Split configurations, Sensor 1 and Sensor 2 run in opposite directions from a central point.

• For Line configurations, Sensor 1 and Sensor 2 run in the same direction along the fence. 

System configuration
Select the System tab on the Alarm Screen window. Figure 7 illustrates the System window for the 
FP1100X Series sensor. The FP1400 System screen is the same as the FP1100X System window. 
The numbered points in the illustration correspond to the configuration procedure that follows. 

1. Specify the Length Units and Sensor Layout for this installation. 
Length Units are Meters or Feet.
For the Sensor Layout, select Loop for configurations in which Sensor 1 and Sensor 2 run in 
opposite directions in one cable; select Line for configurations in which Sensor 1 and Sensor 2 
run in the same direction in one cable; select split for configurations in which Sensor 1 and 
Sensor 2 run in opposite directions in two cables (see Figure 6). 

2. Ensure that the Auto Gain Enable box is checked (default is checked).
Once the Auto Gain and Auto Bias indicators change from light green to dark green, wait at 
least 30 seconds to ensure the Auto Gain process is complete, before proceeding with step 3.

3. Select the Auto Set button. 
The Auto Set process may take several minutes to complete. While the Auto Set process is 
running the System Status will indicate Initializing. When the Auto Set process is complete, the 

Note The Split configuration can be used only with the FP1100X Series.

CAUTION The configuration settings should be adjusted only by a factory trained 
technician.

Figure 7 FiberPatrol System configuration (installer access level)

Note If you change the Length Units or the Sensor Layout you must restart 
the software for the change to take effect.

specify the Length Units

sensor unit icon

0 m point

licensed length to end point
detected cable cut

(installed length of sensor cable)

and Sensor Layout

Set Points and Channel
Status indicators light green

verify Auto Gain Enabled
is checked

select the Auto Set button

dark green Auto Gain
dark green Auto Bias

check the Actual Start
and Actual End of

Sensor 1 and Sensor 2

Advanced Settings button
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Set Start and Set End for each sensor, and the System End fields will be populated. The 
Scales and Offsets will be set to default values. The System Status should now be Armed. 

4. Verify that the Actual Ends of Sensor 1 and Sensor 2 are as expected (these values are 
entered automatically by the system and are based on the optical length of the sensor cable). 
Verify that the value of the Offsets are 0 and the Scales are 1.

5. Verify that the Channel Status and Set Points indicators display light green, and the Auto Gain 
and Auto Bias indicators display dark green.

Advanced Settings

The Advanced Settings can be used by a factory trained technician to fine-tune a configured and 
calibrated FiberPatrol sensor. However, the use of the Advanced Settings requires in-depth 
knowledge of the sensor. Contact Technical Support for additional information before using the 
Advanced Settings feature. 

Calibration setup 

Optical location identification  

Note Wait for the Auto Set (length calibration) process to complete before 
proceeding with the system configuration.

Note If the system is unable to calibrate itself within 5 minutes a popup will 
display indicating that length calibration has failed.
In this case, wait an additional 5 minutes for the system to settle, and 
reselect the Auto Set button.

CAUTION  Do NOT adjust the Advanced Settings without direct technical support.

Figure 8 Advanced Settings dialog

Note Verify that the initial configuration was completed.

Note The location reported by the FiberPatrol sensor unit is determined by the 
optical distance of the sensor fiber within the cable. This length is similar 
to a measurement made by OTDR equipment. The optical distance can 
be up to 3% greater than the cable length due to the Helix factor of the 
fiber optic cable.

Note The FiberPatrol sensor unit requires a minimum of four identified location 
points along the sensor cable. These points are essential for the accurate 
placement of vertices during the map creation process.

There are a number of critical factors which are 

Contact Technical Support BEFORE 
affected by the Pulse Rate and Frame Rate.

adjusting the Advanced Settings.
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In FiberPatrol installations, the actual length of the sensor cable does not match the length of the 
protected fence. Adjustments must be made for the non-sensing lead cable between the 
equipment room and the fence, as well as for site features that require extra sensor cable 
(i.e., gates, bypasses, service loops, sensitivity loops, isolation loops). Therefore, to ensure 
location accuracy on the map display, and for alarm reporting, you must conduct extensive location 
calibration testing to match site features and zone boundaries to cable length. 

The recommended method for location calibration is to have one person, the tester, proceed 
counter-clockwise around the perimeter doing tap tests (see Location calibration - the tap test on 
page 14) at specified site features and zone boundary locations. The second person monitors the 
tests in the control room, recording the locations of the features and zone boundaries. The tester 
and monitor should maintain communications during this process to ensure location accuracy.

The FiberPatrol system can also be setup by one person. In this case, the person synchronizes 
their watch with the time displayed by the FiberPatrol sensor unit, and then walks around the 
perimeter tapping the sensor cable sequentially at the locations of the site’s features. As the tap 
tests are conducted, the person must carefully note the time and location of each test. Once the 
tap tests are completed, the tester returns to the FiberPatrol computer, reviews the results of the 
tests in the Alarm and Event Logs, and records the appropriate details for future use in the Map 
Manager software.

Location calibration - the tap test    

To mark the features and zone boundaries for the FiberPatrol software, tap the sensor cable 
repeatedly in a rapid sequence (for 5 to 10 seconds) at the same location using a small object 
(e.g., a pencil, pen, screwdriver). Use light to moderate force for each tap (i.e., a flick of the wrist) 
and keep the amount of force consistent. Conduct a series of three tap tests at the location of each 
feature, or zone boundary, waiting at least 15 seconds between tests. Calculate the average 
location from the three tests at each point and use the average to set the location of the feature in 
the system software. Use the table in Appendix C to record the test results.  

Note Refer to Supervisor functions on page 65 for descriptions of FiberPatrol 
menu items.

Note By convention, Sensor 1 (from the sensor unit or from location 0) goes in 
the direction of increasing zone numbers (i.e., Sensor 1 starts and runs to 
zone 1 then zone 2 then zone 3 etc.).

Note For location calibration and setup, always tap directly on the sensor 
cable, not on the fence fabric.

Note Refer to the Installer access level Log sub-panel for the location 
calibration test results. Figure 9 shows the Location column on the Log 
sub-panel for the Installer access level.

Note Senstar recommends that the desired locations of the Virtual Zone 
boundaries and site features be indicated on the perimeter fence before 
doing the tap tests (e.g., use tape or string to mark the locations). 
If CCTV camera coverage will provide visual alarm assessment, ensure 
that the fields of view from adjacent cameras provide an 8 m overlap.
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Tap test setup

1. On the Signal sub-panel, set the Disturbance Life and the Event Life to 10 seconds.

2. Select Configure > Alarm Auto Clearing and check the Automatically Clear Alarms and Upon 
Completion checkboxes. Set the time to 10 seconds and apply the changes (see Figure 10). 

Note If the tap tests are being performed and recorded by one person, that 
person’s watch must be synchronized with the time setting of the 
FiberPatrol sensor unit in order to match the alarm times with the alarm 
locations when reviewing the alarms on the Log sub-panel.
If the tap tests are being performed by one person and recorded by 
another, maintain communication between the control room and the 
perimeter to ensure that the alarm times and locations are matched.

Figure 9 Location column on FP1400 Installer level Log panel

Note Once the location calibration is completed, restore the default settings.

Figure 10 Temporary settings for location calibration

select the Automatically Clear Alarms After checkbox,
set the time period to 10 seconds

and select the Upon Completion checkbox

set the disturbance Life and

use the default 
settings

the Event Life to 10 seconds
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Location Calibration for Loop configurations
On the System tab:

1. Set the Sensor Layout to Loop.

2. Set the Length Units to either Meters or Feet.

3. Save the configuration (select the Configure menu > Save Configuration).

4. If you changed the setting for Sensor Layout or Length Units, restart the software.

Calibrating the Set Start for Sensor 1 and the Set End for Sensor 2

Adjust the Detection Settings (see Tap test setup on page 15).

1. Set the Sensor 1 Offset = 0, Sensor 1 Scale = 1, Sensor 2 Offset = 0, Sensor 2 Scale = 1, 
System Offset = 0 and System Scale = 1.

2. Proceed to a point that is 10 m (33 ft.) away from the sensor start point on the Sensor 1 side 
and conduct 3 tap tests at this location. Wait at least 15 seconds between each test.

3. Calculate the average location of the 3 tests for Sensor 1 (low value). 
For the Sensor 1 start point:
Sensor 1 (low value) - 10 m = Start point of sensing for Sensor 1
Subtract 10 m for the start point service loop.
If there is an optional isolation loop, subtract another 10 m from the result to put the start point 
inside the isolation loop.

• e.g., average location of 3 tap tests for Sensor 1 = 134 m
subtract 10 m to get back to the start point of Sensor 1
(134 m - 10 m = 124 m)
subtract 10 m for the splice point service loop
(124 m - 10 m = 114 m)
in this example (see Figure 11) there is an isolation loop, subtract 10 m for the isolation 
loop
(114 m - 10 m = 104 m)
the Set Start for Sensor 1 = 104 m

4. Set the value of the Set Start for Sensor 1 to the above result (104 m).

5. Save the configuration (select the Configure menu > Save Configuration).

6. Calculate the average location of the 3 tests for Sensor 2 (high value).
For the Sensor 2 end point:
Sensor 2 (high value) + 10 m = end point of sensing for Sensor 2
Add 10 m for the splice point service loop.
Add 10 m to put the end point inside the optional isolation loop.

Note For Sensor 1, the FiberPatrol cable between the Sensor Unit and the 
detection start point on the fence must be set to non-sensing.
For Sensor 2 the end of the FiberPatrol sensing region must be defined.

Figure 11 Tap test location - Set Start Sensor 1 (fully closed loop example)

 service 
loop (10 m)isolation

loop (13 m)

 service 
loop (10 m)

start/end point post 10 m (33 ft.)

from start point 
tap cable away 

start point (Sensor 1 =>)start point (<=Sensor 2)
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• e.g., average location of 3 tap tests for Sensor 2 = 2734 m
add 10 m to get to the end point of Sensor 2
(2734 m + 10 m = 2744 m)
add 10 m for the splice point service loop
(2744 m + 10 m = 2754 m)
add 10 m if there is an optional isolation loop
(2754 m + 10 m = 2764 m)
the Set End for Sensor 2 = 2764 m

7. Set the value for Set End Sensor 2 to the above result (2764 m). 

8. Save the configuration (select the Configure menu > Save Configuration).

Calibrating the Set Start for Sensor 2 and Set End for Sensor 1  

Adjust the Detection Settings (see Tap test setup on page 15).

1. Verify the Sensor 1 Offset = 0, Sensor 1 Scale = 1, Sensor 2 Offset = 0, Sensor 2 Scale = 1, 
System Offset = 0 and the System Scale = 1.

2. Proceed to a point that is 10 m (33 ft.) away from the sensor start point on the Sensor 2 side 
and conduct 3 tap tests at this location. Wait at least 15 seconds between each test. 

3. Calculate the average location of the 3 tests for Sensor 2 (low value). 
Calculate the average location of the 3 tests for Sensor 1 (high value).

4. For the Sensor 2 start point:
Sensor 2 (low value) - 10 m = Start point of sensing for Sensor 2 (Set Start 2)
Subtract 10 m for the start point service loop.
Subtract 10 m if there is an optional isolation loop, to put the Sensor 2 start point inside the 
isolation loop.

Figure 12 Entering the Set Start for Sensor 1 and Set End fore Sensor 2 (from example above)

Note For Sensor 2, the FiberPatrol cable between the Sensor Unit and the 
start point of the perimeter must be set to non-sensing.
For Sensor 1 the end of the FiberPatrol sensing region must be defined.

Figure 13 Tap test location - Set Start Sensor 2 (fully closed loop example)

Sensor 1 start of detection

Sensor 2 end of detection

 service 
loop (10 m) isolation

loop (13 m)

 service 
loop (10 m)

10 m (33 ft.)
from S2 start
tap cable away 

start point (Sensor 1 =>)start point (<=Sensor 2)

start/end point post 
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5. Set the value of the Set Start for Sensor 2 to the above result.

• e.g., average location of 3 tap tests for Sensor 2 = 136 m
subtract 10 m to get back to the start point of Sensor 2
(136 m - 10 m = 126 m)
subtract 10 m for the splice point service loop
(126 m - 10 m = 116 m)
subtract 10 m if there is an optional isolation loop
(116 m - 10 m = 106 m)
the Set Start for Sensor 2 = 106 m

6. Save the configuration (select the Configure menu > Save Configuration).

7. For the Sensor 1 end point:
Sensor 1 (high value) + 10 m = End point of sensing for Sensor 1
Add 10 m for the start point service loop.
If there is an optional isolation loop, add 10 m to put the end point inside the isolation loop.

8. Set the value for Set End for Sensor 1 to the above result.

• e.g., average location of 3 tap tests for Sensor 1 = 2738 m
add 10 m to get to the end point of Sensor 1
(2738 m + 10 m = 2748 m)
add 10 m for the start point splice loop
(2748 m + 10 m = 2758 m)
add 10 m if there is an isolation loop
(2758 m + 10 m = 2768 m)
the Set End for Sensor 1 = 2768 m)

9. Save the configuration (select the Configure menu > Save Configuration).

Calibrating the Sensor 2 Offset

1. Refer to Calibrating the Set Start for Sensor 1 and the Set End for Sensor 2 on page 16, to 
determine the Sensor 1 (low value) and Sensor 2 (high value) results from the tap tests.

2. Add the Sensor 1 (low value) and Sensor 2 (high value) results to determine the Sensor 2 
Offset.
e.g., 134 m + 2734 m = 2868 (Sensor 2 Offset)

3. Set the Sensor 2 Offset to the above result.

4. Set the Sensor 2 Scale to -1.

5. Save the configuration (select the Configure menu > Save Configuration).

Calibrating the System Offset

1. Verify that the System Offset = 0 and the System Scale = 1.

Figure 14 Calibrated Sensor Parameters (from examples above)

Set Start values for Sensors 1 & 2

Sensor 2 Offset

Set End values for Sensors 1 & 2
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2. Save the configuration (Select the Configure menu > Save Configuration).

Additional Notes:

If you use the settings System Offset = 0 and System Scale = 1, the start of the sensing cable will 
not be 0 m. In most installations, having the start of the sensing cable set to 0 m is not useful. 
However, if it is desired to have the start of the sensing cable be at the 0 m mark, perform the 
following procedure:

1. Multiply the Set Start value for Sensor 1 by -1 and enter the result in the System Offset box.

2. Set the System Scale = 1.

3. Save the configuration (Select the Configure menu > Save Configuration).

4. Proceed to the physical start point of the sensing cable and do additional tap tests to verify the 
Set Start and System Offset values are correct.

Calibration setup for Split configurations

For Split configurations, location 0 (the sensor start point) is at the terminated end of Sensor 1 (the 
farthest point on Sensor 1 from the processor). The sensor end point, location n (n = the total 
optical length of the sensor cable) is at the terminated end of Sensor 2 (see Figure 15). Included in 
the total length of the sensor is the amount of lead cable between the sensor unit equipment and 
the protected fence. 

1. Set the Sensor Layout to Split.

2. Set the Length Units to either Meters or Feet.

3. Save the configuration (select the Configure menu > Save Configuration).

4. If you changed the setting for Sensor Layout or Length Units, restart the software.

Calibrating the Sensor Scales and Offsets

Adjust the Temporary Detection Settings (see Calibration setup on page 13).

Note The FP1400 series sensor does not support the Split configuration.

Figure 15 Disturbance location calculation (Split configurations)

Figure 16 Tap test location - Set Start (Split configuration)

location 0

system length = 2a + b + c

location n

location of disturbance d1 (S1) = a + b - d1
location of disturbance d2 (S2) = 2a + b + d2

S1 end point S2 start point S2 end point

lead cable

S1 start point

 service 
loop (10 m)

S1 end module
tap cable near 

location 0
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1. Set the Sensor 1 Scale to -1, and set the Sensor 2 scale to 1.

2. Set the Sensor 1 Offset and the Sensor 2 Offset to the Sensor 1 Set End value. 

3. Set the System End to = (Sensor 1 Set End value) + (Sensor 2 Set End value).

4. Save the configuration (Select the Configure menu > Save Configuration).

Verify the sensor start point

1. Conduct a series of 3 tap tests to create 3 alarms at location 0. Location 0 is at the S1 end 
module and represents the start point of detecting cable.

2. Verify that the alarm results are not negative (must be a positive value). 

3. If the alarm results return negative values adjust the System Offset to compensate for the 
negative number (e.g., if the test returns a negative value of - 5 m, set the System Offset to 
5 m to compensate).

4. If the System Offset is adjusted, repeat the series of 3 tap tests to verify the new setting 
(results must be positive values for each test).

To ensure location accuracy on the map display, and for alarm reporting, you must conduct 
location accuracy testing to match site features and zone boundaries to cable length. This location 
accuracy testing is then used for location calibration. Beginning at Location 0, proceed along the 
fence conducting a series of 3 tap tests to create 3 alarms at each feature and zone boundary.

Location calibration for Split configurations:

1. Conduct a series of 3 tap tests to create 3 alarms at the Sensor 1 end module (location 0) 
(i.e., the detection start point or 0 footmark of detecting cable). Wait at least 15 seconds 
between each test. Record the GPS coordinates and a brief description of the location and the 
start time of each test on the calibration sheet. This will be the start point for the first zone.

2. Proceed along the fence to the first feature or to the designated end point of the first zone. 
Conduct a series of 3 tap tests to create 3 alarms. Wait at least 15 seconds between each test. 
Record the GPS coordinates and a brief description of the location and the start time of each 
test on the calibration sheet.

3. Continue this process until reaching the end of the detecting section of sensor cable for 
Sensor 1 (i.e., at the point where the lead cable runs from the fence to the sensor unit). This 
should also be the start point of the detecting sensor cable for Sensor 2. The tap tests at this 
location may cause alarms on both Sensor 1 and Sensor 2.

4. Conduct as many tap tests as required between the fence and the sensor unit to identify the 
lead cable for Sensor 1 and Sensor 2.

5. Return to the fence (beginning of Sensor 2 detecting cable) and continue this process until 
reaching the end of the detecting cable for Sensor 2 (Sensor 2 end module, Location n on 
Sensor 2).

6. Go to the Event Logging sub-panel, and record the locations of the alarms that were 
generated during the tap tests. Calculate the average location of each set of 3 tap tests 
(alarms) for each feature and zone boundary location and record the result in the Location/
calibration table.

7. Make a copy of the completed Location/calibration table and keep it in a safe place.

Calibration setup for Line configurations
1. Set the Sensor Layout to Line.

2. Set the Length Units to either Meters or Feet.

3. Save the configuration (select the Configure menu > Save Configuration).

4. If you changed the setting for Sensor Layout or Length Units, restart the software. 
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Calibrating the Set Start location 

1. Set the Sensor 1 Offset = 0, Sensor 1 Scale = 1, Sensor 2 Offset = 0, Sensor 2 Scale = 1, 
System Offset = 0 and the System Scale = 1.

2. Proceed to a position 10 m (33 ft.) from the start point of the sensing cable. Conduct three tap 
tests at this location, waiting at least 15 seconds between tests (see Location calibration - the 
tap test on page 14).

3. Take an average location from the 3 tests, and subtract 10 m from the average location.

4. If there is a splice point service loop at the start of the sensing cable, subtract the 10 m loop.

5. If there is an optional isolation loop at the start of the sensing cable, subtract another 10 m 
from the result (to place the start point inside the isolation loop).

6. Enter the result in the Set Start box for both Sensor 1 and Sensor 2 (they will nominally have 
the same values for Set Start).

• e.g., average location of 3 tap tests = 86 m
subtract 10 m to get back to the start point
(86 m - 10 m = 76 m)
subtract 10 m for the service loop
(76 m - 10 m = 66 m)
if there is an optional isolation loop, subtract 10 m 
(66 m - 10 m = 56 m
the Set Start for Sensor 1 and Sensor 2 is 56 m

7. Save the configuration (Select the Configure menu > Save Configuration).

Calibrating the Set End position

1. Proceed to a location that is 10 m (33 ft.) before the end point of the sensing cable and 
conduct a series of 3 tap tests at this location, waiting at least 15 seconds between tests.

2. Take an average location from the 3 tests, and add 10 m to the average location.

3. Add 10 m for the splice point service loop.

4. Enter the result in the Set End boxes for Sensor 1 and Sensor 2.

• e.g., average location of 3 tap tests = 1462 m

Figure 17 Tap test location - Set Start (line configuration)

Note The FiberPatrol cable between the Sensor Unit and the start point of the 
perimeter fence must be set to non-sensing. 

Note The location for Sensor 1 and Sensor 2 will nominally be the same.

Note The end of the FiberPatrol sensing cable must be defined. The Set End 
values for Sensor 1 and Sensor 2 define the end location of the sensor.

Note The location for Sensor 1 and Sensor 2 will nominally be the same.

 service 
loop (10 m)isolation

loop (13 m)

start point post 
10 m (33 ft.)

from start point 
tap cable away 
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add 10 m to get to the end point
add 10 m for the splice point service loop
(1462 m + 10 m + 10 m = 1482 m)
the Set End for Sensor 1 and Sensor 2 = 1482 m)

5. Save the configuration (Select the Configure menu > Save Configuration).

6. Proceed to the end point of the sensing cable and conduct a series of tap tests to verify the 
setting.

Calibrating the Offsets and Scales

1. Verify the Sensor 1 Offset = 0, Sensor 1 Scale = 1, Sensor 2 Offset = 0, Sensor 2 Scale = 1, 
System Offset = 0 and the System Scale = 1.

2. Save the configuration (Select the Configure menu > Save Configuration).

Additional Notes:

If you use the settings System Offset = 0 and System Scale = 1, the start of the sensing cable will 
not be 0 m. In most installations, having the start of the sensing cable set to 0 m is not useful. 
However, if it is desired to have the start of the sensing cable be at the 0 m mark, perform the 
following procedure:

1. Multiply the Set Start value for Sensor 1 by -1 and enter the result in the System Offset box.

2. Set the System Scale = 1.

3. Save the configuration (Select the Configure menu > Save Configuration).

4. Proceed to the physical start point of the sensing cable and do additional tap tests to verify the 
Set Start and System Offset values are correct.

Locating the site features and zone boundaries
To draw the perimeter line on a site map, and to accurately display the location of alarms, you 
must determine the position of the site’s features and zone boundaries relative to the length of 
sensing sensor cable. To accomplish this, one person goes around the perimeter causing alarms 
at all site features and zone boundaries, while a second person monitors the alarms in the control 
room. Create a series of three alarms at each feature, and use the average value of the three test 
results for the feature’s location. The tester requires a detailed perimeter site plan that clearly 
identifies each feature and zone boundary that must be located for the map display.

1. Make a copy of the Location/calibration table from Appendix c (see Figure 18 for an example 
of the Location/calibration table).

2. Conduct a series of 3 tap tests at each site feature and Zone boundary location waiting at least 
15 seconds between each test. Note the time of each test on the Location/calibration table.

3. Go to the Log sub-panel, and record the locations of all the alarms that were generated during 
the tap tests. Calculate the average location of each series of 3 tap tests (alarms) for each 
feature and Zone boundary location and record the result in the Location/calibration table.

4. Make a copy of the completed Location/calibration table and keep it in a safe place.  

Note For the Split configuration, begin testing at location 0 (the S1 end 
module).



Locating the site features and zone boundaries

FiberPatrol IDS Software Guide Page 23

Figure 18 Example Location/calibration table

Note The FiberPatrol system uses “soft” zone boundaries, which are defined in 
software. The location resolution of FiberPatrol is approximately 4 m 
(13 ft.). Therefore, the CCTV coverage used for alarm assessment 
should provide an overlapping field of view of at least 8 m (26 ft.) at all 
zone boundaries (see Figure 19).

Figure 19 Overlapping CCTV visual assessment

tap point # description time/location 1 time/location 2 time/location 3 avg. location

1 start point/zone1 start 8:55/11 m 8:56/10 m 8:57/11 m 11 m

2 corner1/zone1 end/zone2 start 9:01/56 m 9:02/59 m 9:03/55 m 57 m

3 corner2/zone2 end/zone3 start 9:07/234 m 9:08/230 m 9:09/228 m 231 m

4 service loop1 1st edge 9:11/296 m 9:11/302 m 9:12/304 m 301 m

5 service loop 1 2nd edge 9:14/314 m 9:15/310 m 9:16/317 m 314 m

6 zone3 end/zone4 start 9:20/327 m 9:21/331 m 9:22/330 m 329 m

7 main gate 1st edge/zone4end/
zone5 start

9:27/362 m 9:28/367 m 9:29/368 m 366 m

8 main gate 2nd edge/zone5 
end/zone6 start

9:33/401 m 9:34/395 m 9:35/397 m 398 m

9 corner 3/zone6 end/zone7 
start

9:40/422 m 9:41/426 m 9:42/428 m 425 m

10 back gate 1st edge/zone7end/
zone8 start

9:47/466 m 9:48/468 m 9:49/468 m 467 m

11 back gate 2nd edge/zone8 
end/zone9 start

9:51/496 m 9:52/492 m 9:53/498 m 495 m

12 corner 4/zone9 end/zone10 
start

10:07/544 m 10:08/549 m 10:09/552 m 548 m

13 service loop2 1st edge 10:12/626 m 10:13/629 m 10:14/631 m 629 m

14 service loop2 2nd edge 10:15/644 m 10:13/641 m 10:14/646 m 644 m

15 zone10 end/man gate 1st 
edge/zone 11 start

10:19/683 m 10:20/686 m 10:21/687 m 685 m

16 man gate 2nd edge 10:22/708 m 10:23/712 m 10:24/709 m 710 m

17 zone11 end/end point 10:28/784 m 10:29/788 m 10:30/786 m 786 m

8 m overlap (4 m/side minimum)
software defined zone boundary
perimeter fence

camera field of view

CCTV camera
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Zone boundary and site feature identification
The following figures illustrate the types of features that should be identified and located on the 
FiberPatrol map. To accurately locate and display alarms on a scale site map, the FiberPatrol 
software requires the locations of the start point of sensing cable; the end point of sensing cable; 
all zone boundaries (beginning and end of each zone); service loops; sensitivity loops; isolation 
loops (anywhere that extra cable is attached to the fence) corners and perimeter direction 
changes; sensor cable bypasses; gates; buildings, structures and other obstacles that are located 
on the perimeter. 

At the start point of sensing cable

At the start point of the sensing cable, tap the cable 10 m away from the start point post and 
subtract 20 m to confirm the start point location. 

At splice locations

Tap the cable one fence panel away from the service loop(s) at splice locations.

At sensitivity loops (corners, tension posts, heavy gauge posts)

Tap the cable at the center of the sensitivity loop where it crosses the fence post.

Figure 20 Tap test location - sensor start point

Figure 21 Tap test location - outdoor splices

Figure 22 Tap test location - at corners or heavy gauge posts

tap cable 10 m away

 service 
loop (10 m)

from start point post 
10 m (33 ft.)

tap cable 1 panel away from service loop tap cable 1 panel away from service loops

tap cable at center of
sensitivity loop over the post
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At gate locations

Tap the cable one fence panel away from the isolation loop(s) at gate locations, where the gate will 
be assigned as an independent zone. Measure back to the isolation loop (e.g., 3 m) and add 10 m 
to place the zone boundary inside the isolation loop. (On the far side of the gate subtract the 
distance back to the isolation loop and 10 m to place the zone boundary inside the isolation loop.) 

Tap the cable one fence panel away from the gate location if there are no service loops or isolation 
loops and the gate will be included as part of another zone.

Tap the cable one fence panel away from the service loop(s) at gate locations, where the gate will 
be included as part of a zone.

At bypass locations

Tap the cable two fence panels away from each isolation loop at bypass locations. Record the 
location results for both sides of the obstacle. Measure back to the obstacle and add, or subtract, 
10 m for each isolation loop. Enter the calculated values as the bypass start and end locations.

Figure 23 Tap test location - gate (independent zone)

Figure 24 Tap test location - gate (part of zone, no service/isolation loops)

Figure 25 Tap test location - gate (part of zone)

Figure 26 Tap test location - bypassed obstacles

tap cable 1 panel away from isolation looptap cable 1 panel away from isolation loop

isolation
loop

isolation
loop loop

service

tap cable 1 panel away from gatetap cable 1 panel away from gate

tap cable 1 panel away from service loop

loop
service

loop
service

tap cable 1 panel away from service loop

tap cable 2 panels away 

isolation
loop

isolation
loop

from the bypassed obstacle
tap cable 2 panels away 

from the bypassed obstacle
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At locations of non-linear cable deployment

Tap the cable at the fence posts adjacent to the non-linear deployment. 

At Zone boundary locations

Tap the cable at the location of all soft zone boundaries.

Figure 27 Tap test location - non-linear cable deployment

Figure 28 Tap test location - service loops

Figure 29 Tap test location - zone boundaries

tap cable at post adjacent to non-linear deployment tap cable at post adjacent to non-linear deployment

heavy gauge tension post diagonal brace support heavy gauge tension post

tap cable here tap cable here

tap cable at zone boundary

Zone 1 Zone 2
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Creating the site map
The FiberPatrol IDS software can display alarms on a graphical site map created from a satellite 
image. The map is created with the IDS Map Manager software, and is imported into the 
FiberPatrol IDS software. An internet connection is required to download a satellite image of the 
site. Begin by installing the IDS Map Manager software on the configuration computer.

Acquiring the site map image
Map image navigation

• Use the mouse wheel to zoom in and out.
Double left-click to zoom in.
Double right-click to zoom out.

• Left-click, hold and drag to pan across the image.

• Right-click, hold and drag to rotate the image.

1. Start the IDS Map Manager application.

Figure 30 shows the Map Manager start screen. Figure 31 shows the map creation tools and 
Figure 32 shows the map editing toolbar.  

Note FiberPatrol recommends that the IDS Map Manager software be run on 
a different computer (i.e., not on the FiberPatrol processor). 

Figure 30 IDS Map Manager start screen

tap cable at zone boundary

Zone 1 Zone 2

current zoom
level
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2. To start a New Project select Project > New Project...
The New Project window displays:

3. Enter the Site ID (use any 6 digit number) and Site Name, and then select OK.

Figure 31 Map creation tools

Figure 32 Map editing toolbar

Figure 33 New Project dialog

Hover the mouse cursor over a toolbar item or menu item
and a description of the function will display.

menu bar

tool bar

menus

Undo
Redo

Removes (selected item from map)
Select Area of Interest

Measure the ground distance
Set map orientation to North Up

Go To Location
Extract an Area of Interest

Perimeter Editor
Zone Editor

Perimeter Extender
Perimeter Removal

Split
Merge (N/A)
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4. To select and display a particular location select Map > Go to Location...

5. Enter the GPS coordinates of the site in decimal format (latitude and longitude) and specify 
the Zoom Level (12 - 14) and then select Go.  

6. Save the project file; select Project > Save Project As...
Name the project and save it in a known location (project_name.FPP).  

7. Add a device; select Project > New Device...

• Enter the IP address of the FiberPatrol processor (if you don’t know the processor’s IP 
address, enter 127.0.0.1).

Figure 34 Go to Location dialog

Note If the selected zoom level is too high, there will not be an image 
available (see Figure 35). Reduce the zoom until an image displays.

Note Save the project frequently to prevent data loss from a power outage or 
computer problem.

Figure 35 No image available (reduce the zoom level)

Figure 36 Add New Unit dialog
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• Enter 4122 as the Port number.

• Enter the Device ID (the device ID is 10 followed by the last four digits of the processor’s 
serial number).

• Specify Point-Sensing as the device type.

• Select OK once you have entered the required information.
In the Project tree under Device(s) a device (computer icon) named Sensor - 10xxxx is 
displayed. 

8. Left-click and hold on the device in the Project tree to drag the device to the location of the 
head end equipment on the map.

9. Release the mouse button to drop the computer icon on the map.
Zoom in to verify the processor’s location on the map. 
To reposition the icon, reselect the device on the project tree and drag it to the correct location 
on the map (no undo).

10. Save the project file.

Creating the perimeter
The perimeter fence line, on which the alarm locations will be displayed, is created in IDS Map 
Manager. In order to accurately display the locations of alarms, you place vertices on the perimeter 
line and define the locations of the vertices in the IDS Map Manager software. 

1. Select and highlight the Sensor in the Project tree. Select the Perimeter Editor tool, and then 
select the Perimeter Extender tool. 
The Zoom level should fully display the site’s protected perimeter.

Figure 37 Placing the device icon on the map

Note A vertex is a point on the virtual perimeter that has a defined location 
(e.g., 10 m for the start point vertex). Place vertices only at positions on 
the map where you have obtained a feature location.
Each vertex will be connected to the next vertex with a straight line. The 
indicated lengths represent the ground distance of the segment and the 
total length of the perimeter. The indicated lengths are different from the 
optical sensor lengths.
A minimum of 4 vertices are required for the map creation process.

left-click & hold
drag & drop at 
the desired location
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2. Start at the beginning of the sensing sensor cable, and add the start point vertex to the map. 

3. Proceed around the perimeter map and use the completed location/calibration table to place a 
vertex at each located feature.  

• To remove a vertex, select the Perimeter Removal tool (hover the cursor over the vertex 
and the hand becomes the removal tool) and left-click the vertex. 
When a vertex is removed, the adjacent vertices are joined by a straight line.

• To add a vertex inside an existing line segment, highlight the segment, and select the Split 
Tool. This creates a vertex in the center of the highlighted segment. Left-click and drag 
this vertex to the desired location.

• To change the location of a vertex left click and release to select the vertex, then left click 
and hold to drag the vertex to the desired location.

Figure 38 Drawing the perimeter

Note To end the drawing sequence, select Ctrl + 3. The perimeter line ends at 
the last vertex.

Note Once the perimeter is drawn, a table is created based on the physical 
location of each vertex. The physical (ground) distances must then be 
changed to the optical distances that were obtained during the tap 
testing.

Figure 39 Defining the positions of the perimeter segments

Note For line configurations, the last node can be left unconnected. For 
closed loop configurations, the start and end nodes must be the same.

superimposed start point
and end point vertices

Perimeter segment definition table

select a segment

enter the Start point
and End point
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4. Select each segment and enter the average optical Start and End locations from the Location/
calibration table.

5. Save the Project file.

Select the Area of Interest (AOI)
1. Zoom out so that the AOI encompasses the entire site and rotate the image to obtain the 

desired display.

2. Select the AOI tool. Select the AOI by left-clicking the upper left corner, then moving the cursor 
diagonally across the map and left-clicking the bottom right corner. Keep the AOI aspect ratio 
as close to 5:2, and as centered as possible.

3. Select the Extract AOI button.

Note To use the alarm zones as created in the IDS Map Manager, proceed to 
Select the Area of Interest (AOI) on page 32.

Figure 40 Selecting the Area of Interest

Figure 41 Extracting the Area of Interest

increase the zoom

when either Image Width or Height 

select OK

is approximately 1000
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4. Increase the Zoom on the Area-of-Interest Details field until either the Image Width or Height 
is approximately 1000, and then select OK.

5. When you are prompted to Download Missing Tiles select Yes. 

6. Once the Map Extraction is complete, select OK.

7. Go to the Project menu, and select Export > Definition file(s)...
Use the Browse button to select a folder in a known location (or create a folder) and then 
select Export. When the export process is complete, select OK.

8. Delete the IDS zone definition.txt file from the target folder.

9. Verify that three configuration files were exported to the specified folder (IDS map 
calibration.txt, IDS map image.jpg, IDS perimeter definition.txt) and check the map image 
(open the jpg file). 
If there is no map image, you must re-select the AOI and extract the map at a lower zoom 
level.

10. Save the Project, and close IDS Map Manager.

Importing Configuration Files into the FiberPatrol IDS software
1. Save the three configuration files that were exported from IDS Map Manager to removable 

media.

2. On the FiberPatrol processor, navigate to C:\FiberPatrol\Configuration. Rename the existing 
files by adding ORIG to the end of the file name before the extension (e.g., IDS map 
calibration ORIG.txt).

3. On the FiberPatrol processor, copy the three IDS Map Manager configuration files into 
C:\FiberPatrol\Configuration.

4. Go to the Configure menu, and select Load Configuration.
Verify that the correct map image appears in the Current Alarms sub-panel.

Note The Download Missing Tiles process can take several minutes. Wait 
until the Map Extraction Complete popup displays before proceeding.

Figure 42 Completing the Map extraction

Note The Export function creates four configuration files. However, the IDS 
zone definition.txt file is not required and must be deleted from the 
target folder before the files are imported into the FiberPatrol IDS 
software.

select OK

select Yes
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5. Go to the Help menu, and select About FiberPatrol.
Change the Site ID and Unit ID to the appropriate numbers.

6. Save the Configuration.

Defining the Zone Boundaries (Zone Definitions)    

Figure 43 Verifying the Map image

Figure 44 Setting the Site ID and Unit ID

Figure 45 Zone Definition window

Note The FP1100X series sensor supports up to1440 distinct alarm zones.

Note The minimum length for a FiberPatrol FP1400 zone is 15 m (49 ft.).
The maximum length for a FiberPatrol FP1400 zone is 300 m (984 ft.).

The map image and
perimeter line created
in IDS Map Manager
display when the new
configuration files are
loaded.

Enter the appropriate details for:

Site ID

Unit ID

Site Info

Unit Info
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1. In the Manage menu, select Zone Definition.

2. In the Zone Definition window, enter the average Start and End location of each zone from the 
Location/calibration table that was recorded during the tap testing, beginning with Zone 1.

3. Keep the Zone Labels in ascending order, and with the same nomenclature as used in the 
default configuration (i.e., zone1, zone2, etc.).

4. Change the Zone Names as required.  

5. Once complete, select Apply, and then select Replace.

6. Verify that the Zone Definitions are accurate.

7. Save the Configuration.

Note Right-click a Zone line to add or delete a Zone. 
When a new zone is added, the Start Location and End Location are 0, 
the Zone Label is newzone and the zone name is New Zone. 
All zones must be assigned unique Zone Labels and Zone Names, 
including disabled zones.

Note The end location of one Zone boundary must be the same as the start 
location for the next Zone boundary (i.e., if Zone 1 ends at 100 m, then 
Zone 2 begins at 100 m). 
For a fully closed perimeter, the end point location of the final Zone must 
be the same as the start point location for the first Zone.

Note Do not edit or adjust the Zone Label column. Do not change the Head 
End zone, the Zone Type, Filter settings (Low Freq, High Freq), 
Thresholds, or Display mode at this time.

Note Zone names must begin with a number for use with the Network Manager 
software (e.g, 7: West Fence).

Note Assign meaningful Zone Names, as the Zone Names are displayed 
during alarm activity and are recorded in the Event Log (e.g., change 
Zone3 to 3: Main Gate).

Note To verify the Zone Definitions perform tap tests to create alarms along 
the perimeter. Check all of the features and check the Alarm log to ensure 
that each alarm is reported accurately in the correct zone at the proper 
location. Repeat the tap tests for any alarms that were not reported 
correctly, and make any necessary changes in the Zone Definition 
window.
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Remote Interface/Alarm output setup

There are three methods available for FiberPatrol Remote Interface Alarm output:

• Network Manager

• Relays (via NM and UltraLink I/O)

• ASCII output

1. To setup the Remote Interface connection select Configure > Remote Interface.
The Remote Communication Interface window displays.

• Select Connection is used to select which connection is being configured. 
There are three connections available: A, B and C. 
Other remote interface controls and indicators will display the parameters of the selected 
connection.

• The Enable checkbox enables or disables the remote interface connection (leave enabled). 

• The Broadcast checkbox enables or disables the transmission of data through the remote 
interface. When selected, the FiberPatrol IDS transmits data packets at regular intervals 
(leave enabled).

• Interface Mode is a drop-down menu that selects the remote interface type from the available 
options. The following are two of the standard options.

• In TCP/IP Server mode, the FiberPatrol IDS implements a TCP/IP server. It accepts a 
single connection through the default Port (4122).

• In TCP/IP Client mode, the FiberPatrol IDS implements a TCP/IP client. It connects to a 
TCP/IP server via the specified IP Address and Port.

• The IP Address specifies the remote server’s IP address when TCP/IP Client mode is in use. 
Set to 127.0.0.1 if the server is on the local sensor unit.
The IP Address field is not used in TCP/IP Server mode. 

• The Port Number is the TCP/IP port for the remote interface connection (for server mode the 
Port Number is 4122; for client mode the Port Number must match the TCP/IP port used by 
the remote server). 

• The Report Mode field sets the data format for the selected connection.

Note The primary focus of this manual is on the Network Manager interface. 
Refer to Appendix d for additional Remote interface setup details.

Figure 46 Remote Communication Interface

Note All three of the connection types can be in operation simultaneously.

Note Select Server mode for NMI applications.

selectable Report Modes
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• The Connection Status indicators display the connection status for up to three remote 
connections.

• The Remote Client field displays the identity of the remote client. 
For the TCP/IP modes the identity is the remote computer’s IP address or the DNS name.

• The Communication Monitor field is used to monitor the incoming remote interface messages 
for the selected connection.

Setting Alarm Detection Parameters
The Alarm Detection Parameters are available on the Signal sub-panel. 

• The Disturbance Threshold is the minimum level that a localized disturbance must reach to be 
accumulated and counted towards alarm generation. The Disturbance Threshold is indicated 
by a red line in the disturbance level display. This sets the sensitivity of the system together 
with the Alarm Threshold. The default value is 5.

• The Alarm Threshold is the minimum disturbance count that must accumulate within a location 
range and a time range (determined by the Disturbance Life setting) in order to generate an 
alarm. The Alarm Threshold determines the sensitivity of the system together with the 
Disturbance Threshold. The default value is 10.

• The Duration Threshold is the minimum event duration (in seconds) required in order to 
declare an alarm. The Duration Threshold is used for rejecting events that are too brief to be 
considered a valid intrusion attempt. The default value is 0 (disabled). 

• The Disturbance Life is the length of time, in seconds, for which any localized disturbance is 
retained. If the total amount of disturbance in the localized area does not reach the alarm 
threshold in this period, the accumulated disturbance is discarded. The default value is 15 
seconds.

Note The middle Disturbance graph and the bottom Count graph show 
disturbance signals from the selected Zone.

Figure 47 Event Processing sub-panel (FP1100X series)

FP1100X series detection
parameters and filter cutoffs
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• The Disturbance Mask is used to prevent a single disturbance event from being recorded as 
additional disturbances due to continuing reverberations caused by the initial disturbance. The 
default value is 0.3 seconds.

• The Disturbance Range defines the length of cable (or fence) over which a current disturbance 
event can be added to by additional disturbances in the same general area. The default value 
is 6 m (20 ft.).

• The Event Life is the length of time, in seconds, following an event (alarm) before another 
event (alarm) can be declared at the same location. The default value is 60 seconds.

• The Filter Cutoffs show the settings of the Low frequency and High frequency filters. The filter 
settings are used to customize the sensor’s frequency response to the type and condition of 
the fence on which it is mounted. Correct adjustment of the Filters can increase the signal to 
noise ratio and help to screen out the ambient background noise that is always present.
The high pass filter (Low freq. cutoff) is used to screen out low frequency vibrations such as 
the fence motion caused by steady wind and loose fence fabric. The low pass filter (High freq. 
cutoff) is used to screen out high frequency vibrations. The default settings of the Filter Cutoffs 
are factory set to provide good detection on most types of fences.

Intrusion simulation tests

To test the FiberPatrol sensor you conduct simulations for both cut and climb intrusions. Using the 
Save Raw Data function, thoroughly test the detection along the full length of the sensor cable, 
while recording each test. Use the Load Raw Data function to playback the recorded data and 
adjust the detection parameters if any of the test intrusions fails to report an alarm simulation. 

Once the intrusion testing is completed, briefly run the Save Raw Data function during periods of 
inclement weather (30 seconds to 1 minute max.). Replay the saved data and adjust the detection 
parameters if bad weather causes an unacceptable nuisance alarm rate (NAR). Once the system 
is detecting all intrusion simulations and the NAR is acceptable, the sensor is properly calibrated. 
Update the Factory Configuration to include the processor’s current settings.

Simulated cut intrusion tests

The easiest method for simulating a cut intrusion is to strike the fence with the blade of a medium 
sized screwdriver. Hold the screwdriver by the handle, and flip your wrist to strike a fence wire with 
the blade of the screwdriver. The metal on metal contact generates an impulse that is similar to the 
cutting of a fence wire. Strike the fence firmly, but do not use excessive force. Try to use a 
consistent amount of force each time you strike the fence.

Rather than striking the fence, you can also simulate a cut intrusion by weaving a length of fence 
wire into the panel and then cutting the inserted wire. Both methods generate a signal that is 
similar to the response of an actual cut intrusion. An actual fence cut also creates a significant 
amount of secondary fence noise as the cut section of wire pulls apart.

Simulated climb intrusion tests

For a simulated climb intrusion, the best method is to actually climb the fence. It is not necessary 
to climb over the fence. The tester simply needs to climb on the fence for as long as it takes to 
generate an alarm (typically less than 3 seconds).  

CAUTION Do not adjust the filters without direct technical support.

CAUTION The Save Raw Data function typically creates very large files. Do not use 
the Save Raw Data function for extended periods. When conducting 
intrusion tests, start the Save Raw Data at the beginning of each test, and 
stop it when the test is completed. 
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If climbing on the fence is not possible, dragging a screwdriver across the surface of the fence can 
be used as a climb simulation. Place the blade of a screwdriver against the fence fabric and drag 
the screwdriver across the fence panel while applying light pressure.

Setting the full cable Sensitivity Thresholds

The full cable Sensitivity Thresholds are software settings that control the sensitivity of the entire 
sensor. When correctly set, the full cable Sensitivity Thresholds make the FiberPatrol sensor 
sensitive enough to detect an intruder, while keeping nuisance alarms to a minimum. The following 
procedure requires two people.

1. Go to the Signal sub-panel.

2. Set the Disturbance Life to 15 seconds, and the Event Life to 60 seconds (default values).

3. Have the tester go to a straight section of the fence (away from any service loops, corners, 
and gates), and simulate a fence climb (see Simulated climb intrusion tests on page 38).

4. On the FiberPatrol sensor unit, access the Signal sub-panel and observe the Disturbance 
display and Alarm status. Note the magnitude of the disturbance, and how quickly the gray 
bars turned to red (signaling an alarm). Repeat the climb test five times to determine how a 
typical climb intrusion appears on the display.

5. Raise the Disturbance Threshold and Alarm Threshold and repeat the climb tests, so that the 
test subject always generates an alarm during the climbs at the highest possible threshold 
settings. If raising the thresholds results in a failed test (no alarm) lower the threshold 
accordingly.

• If the climb disturbances are not going above the red line, reduce the Disturbance 
Threshold. 

• If the climb disturbances are well above the red line, increase the Disturbance Threshold.

• If the duration of the climb disturbances are not long enough to cause an alarm, but are 
over the red line, reduce the Alarm Threshold so that an alarm is generated. 

• If an alarm is generated very quickly, increase the Alarm Threshold so that an alarm is 
generated, but it takes more time to generate.

6. Save the Configuration.

Note Conduct an initial climb intrusion test to determine how long it takes to 
generate an alarm at your site.

Note Use protective gloves and suitable footwear to perform the climb intrusion 
testing.

Note Remove any potential sources of vibrations from the vicinity of the 
protected fence. Tree limbs, brush, tall vegetation and any loose objects 
must be removed or secured to prevent them from contacting the fence. 
Loose signs, fittings, hardware, fence fabric, or gates must be tightened 
or repaired to prevent nuisance alarms during inclement weather.

Note Adjusting the Detection Thresholds generally takes some trial and error. 
Test all settings multiple times to ensure that the sensor always 
generates an alarm.
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Setting zone specific Sensitivity Thresholds
Zone specific Sensitivity Thresholds are software settings that control the sensitivity of individual 
Zones. These settings enable either a higher or lower detection sensitivity for a particular zone. 
This procedure is similar to the Global Sensitivity procedure. However, the Threshold settings 
apply only to individual zones.

1. Go to the Signal sub-panel, and verify that the Disturbance Life is set to 15 seconds, and the 
Event Life is set to 60 seconds.

2. Have the tester go to Zone 1 and simulate a series of fence cut intrusion tests and fence climb 
intrusion tests (see Intrusion simulation tests on page 38). Observe the Signal sub-panel 
during the tests. 

• If the Global Sensitivity Settings are acceptable for Zone 1, proceed to Zone 2, and repeat 
the climb tests.

• If the Global Sensitivity Settings for Zone 1 require adjustment, proceed to step 3.

3. To adjust the Sensitivity settings for an individual zone, open the Manage menu, and select 
Zone Definition (see Figure 45).

4. To adjust the sensitivity thresholds for an individual zone, change the threshold value from the 
default value of -1 to the desired value.

5. Perform a series of intrusion tests to verify the new settings.

6. Repeat this procedure for each Zone. 

7. Go to the Configure menu and select Save Configuration (see Figure 67:).

8. On the Configure menu, select Update the Factory Configuration.

Fine tuning detection parameters

The FP1100X and FP1400 series sensors include three settings that are used to fine tune the 
detection response to screen out sources of nuisance alarms. Under the Service menu, select 
Environment Compensation, Motion Rejection - Parallel, and Motion Rejection - Perpendicular.

Note If a zone requires different sensitivity settings in two sections, the zone 
must be divided into two sub-zones (e.g., Zone 7 = Zone 7a + Zone 7b). If 
a zone requires a different sensitivity setting in the middle of the zone, the 
zone must be divided into three sub-zones (e.g., Zone 7 = Zone 7a + 
Zone 7b + Zone 7c). Each zone can be assigned a different sensitivity 
setting (Threshold value) and each zone can report alarms via the same 
output so the 7a, 7b and 7c sub-zones all display alarms in Zone 7.

Note There are three columns in the Zone Definition window related to the 
detection sensitivity settings: Disturbance Threshold, Alarm Threshold 
and Duration Threshold. If a -1 is displayed, then the Global Setting 
applies for that zone (e.g., if the global Disturbance Threshold setting is 
6, then a zone displaying a -1 in the Disturbance Threshold column has a 
Disturbance Threshold of 6). All zones use the Global Settings by default, 
unless the settings are adjusted via the Zone Definition window (all 
threshold values are initially -1).

Note You must select Apply, and then select Replace for the sensitivity 
changes to take effect.
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Environment Compensation

Environment Compensation can be used to help screen out environmental factors like strong wind 
and heavy precipitation that can cause nuisance alarms. Environment Compensation is accessed 
through the Service menu. There are two modes of Environment Compensation, Spatial and 
Temporal. Set Temporal Environment Compensation first.

Spatial Compensation: 

Spatial Environment Compensation dynamically monitors disturbance signals over a longer length 
of the sensing cable (several tens of meters) and removes common-mode disturbance signals 
caused by environmental factors. Spatial Environment Compensation compares the disturbance 
signal of a sensor at a specific location with a range of contiguous locations on both sides. This 
range of contiguous locations is defined by the “Include Length” setting. It does not compare the 
disturbance signal from the immediate locations on both sides, which are defined by the “Exclude 
Length” setting. 

• Enabled? (1 yes, 0 No): Spatial Environment Compensation is applied to the cable section if 
a value of 1 is entered in this column. A value of 0 disables Spatial Environment 
Compensation in the cable section.

• Start and End Locations: The length of a section is defined by entering a start location and 
an end location. The values for the start and end locations use the same unit that was chosen 
in the System panel (meters or feet). Multiple different sections can be defined for Spatial 
Environment Compensation.

• Include Length: This is the length of cable on both sides of a location which are used to 
remove common-mode disturbance signals from a location.

• Exclude Length: This is the length of cable on both sides of a location that are excluded from 
Spatial Compensation. The Exclude Length is always less than the Include Length.

• % Comp: This is the degree of Spatial Compensation applied to each location. Higher 
percentage increases common-mode rejection. 

Figure 48 Fine tuning detection

Figure 49 Environment Compensation screens
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Temporal Compensation: 

Temporal Environment Compensation works at a localized point of the sensor and removes 
background signals based on the point’s history over a time period defined by the “Average Time” 
setting.

• Enabled? (1 yes, 0 No): Temporal Environment Compensation is applied to the cable section 
if a value of 1 is entered in this column. A value of 0 disables Environment Compensation in 
the cable section.

• Start and End Locations: The length of a section is defined by entering a start location and 
an end location. The values for the start and end locations use the same unit that was chosen 
in the System panel (meters or feet). Multiple different sections can be defined for Temporal 
Environment Compensation.

• Average Time(s): This is the time period that Temporal Environment Compensation uses for 
removing slowly-varying background signals at a location.

• % Comp: This is the degree of Spatial Compensation applied to each location. Higher 
percentage increases common-mode rejection.

Motion Rejection – Parallel Settings

In some installations, the fence on which the sensor cable is installed, runs closely alongside a 
roadway or railroad. If heavy vehicles or train traffic passing by the fence cause nuisance alarms, 
then Motion Rejection – Parallel settings should be used to prevent these nuisance alarms. To 
open the Motion Rejection – Parallel settings panel, go to the Service menu and then select 
Motion Rejection – Parallel (see Figure 50).

The first column in the Motion Rejection – Parallel panel lists the section numbers. A section is a 
part of the sensor cable where Motion Rejection – Parallel can be applied to reject vibrations 
caused by nearby parallel motion. Section number 0 is the first section of cable in which Motion 
Rejection – Parallel has been applied. Section number 1 is the second section, etc. Any number of 
sensor cable sections can be defined and each section can use different settings. The defined 
sensor cable sections do not have to be contiguous. Other columns are explained below:

• Enabled? (1 yes, 0 No): Parallel motion rejection is applied to the section if a value of 1 is 
entered in this column. A value of 0 disables the section.

• Start and End Locations: The length of a section is defined by entering a start location and 
an end location. The values for the start and end locations use the same unit that was chosen 
in the System panel (meters or feet). 

• Disturbance Magnitude: Disturbance signals above this threshold setting are analyzed to 
determine a valid parallel motion event.

Figure 50 Motion Rejection - Parallel panel
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• Disturbance Time: An object that is moving parallel to the sensor cable typically generates a 
number of disturbances in a specific pattern at different locations and times. These 
disturbance events are considered to be a cluster, belonging to the same parallel motion event 
if the period between consecutive disturbances is less than the Disturbance Time setting. The 
unit for Disturbance Time is seconds.

• Disturbance Life: Disturbance Life sets the time limit that a disturbance is considered to be 
part of a parallel motion event cluster. Once the disturbance life expires, that disturbance does 
not affect nuisance alarm rejection.

• Delay, sec: Delay is the time, in seconds, for which Disturbance frames are delayed before 
they are analyzed to determine an alarm condition. The Delay time is used to allow for a 
pattern to develop so the nuisance alarm rejection algorithm can work effectively.

• Motion Resolution: For a new disturbance to be part of an existing parallel motion event, its 
location must be within the Motion Resolution distance from the previous disturbance.

• Object Length: For a cluster of disturbances to be classified as a valid moving object, the 
distance traveled must be greater than the Object Length.

• Speed: The speed of an object, calculated from the disturbances in a cluster, must be greater 
than the Speed, m/s (meters per second) setting to be rejected as a valid parallel motion 
event. 

Motion Rejection – Perpendicular Settings

At some installations, particularly airports, large planes taking off and landing can cause vibrations 
that affect the sensor cable when the planes pass over almost perpendicular to the fence. If planes 
cause nuisance alarms when flying low over the fence line at the end of a runway, then Motion 
Rejection – Perpendicular settings can be used to reject these nuisance alarms. To open Motion 
Rejection – Perpendicular settings panel, go to the Service menu and then select Motion Rejection 
– Perpendicular (see Figure 51). 

The first column in the Motion Rejection – Perpendicular panel is section number. A section is a 
part of the sensing cable where Motion Rejection – Perpendicular can be applied to reject 
undesirable perpendicular motion. The section numbering starts from 0 and the second section 
number is 1, etc. Other Motion Rejection columns are explained below:

• Enabled? (1 yes, 0 No): Perpendicular motion rejection is applied to the section if a value of 1 
is entered in this column. A value of 0 disables the section.

• Start and End Locations: The length of a section is defined by entering a start location and 
an end location. The values for the start and end locations use the same unit that was chosen 
in the System panel (meters or feet). 

• Disturbance Magnitude: Disturbance signals above this threshold setting are analyzed to 
determine a valid perpendicular motion event.

Figure 51 Motion Rejection - Perpendicular panel
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• Disturbance Time: An object moving perpendicular to the sensor cable typically generates a 
number of disturbances for a limited time depending on the speed and length of the moving 
object, as well as other factors related to the fence. The Disturbance Time is the period, in 
seconds, in which a moving object is expected to create perpendicular disturbance events.

• Disturbance Life, sec: Disturbance Life sets the time limit that a disturbance is considered to 
be part of a perpendicular motion event cluster. Once the disturbance life expires, that 
disturbance does not affect nuisance alarm rejection.

• Delay, sec: Delay is the time, in seconds, for which Disturbance frames are delayed before 
they are analyzed to determine an alarm condition. The Delay time is used to allow for a 
pattern to develop so the nuisance alarm rejection algorithm can work effectively.

• Motion Resolution: For a new disturbance to be part of an existing perpendicular motion 
event, its location must be within the Motion Resolution distance from the previous 
disturbance.

• Object Length: For a cluster of disturbances to be classified as a valid moving object, the 
distance traveled must be greater than the Object Length.

• Lower Threshold 1, Lower Threshold 2, Lower Threshold 3: The Disturbance Time is 
divided into 3 equal time slots. Lower Threshold 1, Lower Threshold 2, and Lower Threshold 3 
correspond to time slots 1, 2, and 3, respectively. The Disturbance signals must be higher than 
the Lower Threshold 1, Lower Threshold 2, and Lower Threshold 3 settings to reject a 
perpendicular motion event. 

• Upper Threshold 1 (%) and Upper Threshold 3 (%): The Disturbance signals must be lower 
than the Upper Threshold 1 and Upper Threshold 3 settings (time slots 1 and 3) to reject a 
perpendicular motion event. Upper Threshold 1 and Upper Threshold 3 are defined as a 
percentage of the maximum Disturbance signal in time slot 2.

Save Raw Data

An advanced user can use the Save Raw Data function to help fine-tune an FiberPatrol sensor. 
Use the Save Raw Data function during test simulations, and then replay the saved data via the 
Load Raw Data function. Make small adjustments to the detection parameters to find the optimal 
settings whereby each test is detected, while nuisance alarms are minimized. Save Raw Data can 
also be used during periods of inclement weather to further reduce nuisance alarms. The Save 
Raw Data feature creates text files which are saved into the Data Folder (D:\Data). The text files 
can be sent to FiberPatrol technical support for analysis. When enabled, the Save Raw Data 
function saves the configuration folder and creates a sub-folder every 5 minutes. 

CAUTION The Save Raw Data function typically creates very large files. Do not use 
the Save Raw Data function for extended periods. When conducting 
intrusion tests, start the Save Raw Data at the beginning of each test, and 
stop it when the test is complete. Contact the factory for direct technical 
support before using the Save Raw Data feature.

Figure 52 Save Raw Data/Load Raw Data screen
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Load Raw Data

An advanced user can use the Load Raw Data function to help fine-tune an FiberPatrol sensor. 
Use the Load Raw Data function to replay the saved data from detection tests. Make small 
adjustments to the detection parameters while replaying the saved data to find the optimal 
settings. Data recorded during periods of inclement weather can also be loaded and played back. 
This can further reduce nuisance alarms by making small adjustments to the detection parameters 
that will exclude the environmental signals from counting towards alarm generation.

Frequency Display

The FiberPatrol sensor includes a Frequency Display window under the Service menu. In Zone 
Mode, the Frequency Display window enables an advanced user to view FFT amplitudes on a 
zone by zone basis. In Location Mode, you can specify a location and view the FFT amplitudes at 
that location.  

Additional installer level settings

The Installer access level can verify the health of the system by viewing the Signal graph in linear 
mode and dB mode. Linear mode shows the COTDR signal from the cable and dB mode shows 
the approximate loss in the cable and the location of the end (see Figure 54).

Refresh button

The Refresh button resets the net signal calculation (used to for the net signal status checkpoint 
and the net signal graph on the system tab).

Figure 53 Frequency Display screen

Note DO NOT use the Signal graph in place of the OTDR scanning during the 
system installation.
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Advanced Settings

The Advanced Settings button provides access to two settings that can be used to adjust the 
system’s response based on the mounting surface. The Pulse Rate and the Frame Rate. 

Configuration File Safety Backup

Once the system is setup and configured, it is strongly recommended that a backup copy be made 
of the configuration folder: C\FiberPatrol\Configuration. Save the Configuration folder to 
removable media so the configuration data can be reloaded in the event of a catastrophic system 
failure.

Note The Advanced Settings should be adjusted only if the system’s detection 
sensitivity cannot be setup satisfactorily using the standard detection 
parameters. DO NOT adjust the Advanced Settings without direct 
technical support.

Figure 54 Additional settings

Use the signal graph to verify
the health of the system
in Linear mode or by dB.

The Advanced Settings can
be used to adjust the sensor
when the standard detection

settings are not adequate.
(Requires direct technical support.)

The Refresh button resets the
system’s net signal calculation.
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3 Maintenance/troubleshooting

System Diagnostics 
The FiberPatrol IDS software monitors the FiberPatrol system for any operational issues or 
component malfunctions. System self-diagnostics can detect and report the following conditions:

• Sensor cable or lead cable damage

• Loss of optical connections to Controller

• Failure of certain optical or electronic components in Controller

• Loss of communication between Controller and Processor

• Malfunction of plug-in data acquisition card in Processor

The following conditions cannot be self-diagnosed

• Processor malfunction or crash

• Operating system and software driver errors

• FiberPatrol software interface crash

Some conditions resulting from incorrect or improper system installation, configuration, or 
calibration may also not be detectable by system self-diagnostics. 

System Status Reporting 
When FiberPatrol software detects an error condition, it alerts local and remote operators by 
reporting the corresponding System Status and generating Head End alarms. System Status 
indicator in the lower left corner of the FiberPatrol software interface can show four general states: 

• Armed - normal operation

• Cable Cut - sensor cable cut

• Warning - non-critical failure, intrusion detection still possible

• Disarmed - critical failure that disables the system

Head End alarms are generated and reported when the general system status changes to 
Disarmed. Head End alarms are treated by the FiberPatrol system the same way intrusion alarms 
are. By default, they are reported with a location of -1000 and zone label HeadEnd, and are 
displayed on the map at the point where the system head end equipment is located. Head End 
alarms can be cleared. However, clearing a Head End alarm does not fix the underlying problem. 
Even if the current system status is Armed, recent Head End alarms may indicate a recurrent 
system problem that needs to be addressed.
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Remote Systems

For a system located at a remote site and monitored via a network, the following could be signs of 
a system malfunction:

• Remote connection is dropped or was not established

• Unit status alarm is received from the remote system

• Unit Disarmed status is reported

If a remote connection is active, using a remote desktop application to connect to the FiberPatrol 
Alarm Processor can be an effective way to troubleshoot the system.

If it is impossible to establish a remote connection to any of the equipment at the remote site, then 
it is likely to be a network issue, which should be referred to IT personnel. 

If other equipment at the site is still communicating, but the FiberPatrol system is not, then it could 
be a FiberPatrol system failure, requiring a site visit for further diagnostics.

Local Systems

Locally, the state of the system can be quickly assessed by checking the Alarm Processor screen. 
The following are indications of a system malfunction:

• Blank, blue, or frozen screen

• Windows error messages

Any issues detected by self-diagnostics would be indicated in the System Status field: 

• Warning

• Disarmed

• Cable Cut

• also by Active or recent Head End alarms

If the system appears to be armed and operational, the following signs may indicate improper 
system settings or calibration:

• Failure to generate sensor alarms

• Incorrect sensor alarm locations

Common Scenarios

Power surges and outages not only temporarily disable security systems, they can also cause 
serious equipment problems especially if occurring often. FiberPatrol systems are configured to 
automatically recover from a power outage. However, every time electronic and computer 
equipment is hard-booted, there is the potential of an operating system or a file structure 
corruption, or hardware damage. Unstable line power is particularly dangerous as it may cause a 
rapid succession of reboots that may leave equipment damaged or in an error state requiring a 
manual reboot. A properly configured uninterruptable power supply (UPS) is recommended for 
use with FiberPatrol equipment. Soft shutdown and remote reboot functionalities are also strongly 
recommended. 

Alarm Processor crashes are rare occurrences for properly installed and configured equipment. 
Often they are caused by external factors such as elevated operating temperature, unstable line 
power, or improper handling of back panel cabling. Alarm Processor hardware and software 
configuration is stable under normal operating conditions. Intermittent or fatal crashes can be 
caused by a hardware malfunction, such as a hard drive failure. Hardware failure is often a 
consequence of abnormal operating conditions. 
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Unplugged, loose, or mishandled cables are a common cause of system downtime. Fiber-optic 
jumpers, in particular, can be easily damaged when handled carelessly. Even power cables can be 
incorrectly installed, or partially pulled out leaving them half-plugged and creating a spark gap. 

Dirty single-mode fiber optic connectors are often to blame for optical losses in the system. Fiber 
optic patch cables should never be disconnected, unless absolutely necessary. Unplugged fiber 
connectors must be covered immediately with caps. The fiber connectors should always be 
inspected and cleaned before they are plugged in. 

Swapped cables can cause error states that are difficult to diagnose. FiberPatrol head end 
equipment uses fiber optic patch cables to connect the lead cable to the Controller. Additionally, 
data cables connect the Controller and Processor modules. Refer to the Site planning and 
installation guide for FiberPatrol Head End connection details. 

Installation, configuration, or calibration issues generally become evident when the system is first 
armed and tested. Any problems must be rectified before commissioning the system. In addition, 
care must be taken to avoid any installation, configuration, or calibration issues following system 
repairs, reconfigurations, or upgrades. Accidents, such as falling trees and tree limbs and 
installation problems at gate areas are the leading causes of outdoor sensor cable damage.

Troubleshooting procedures
This section outlines the procedures to follow when checking, or troubleshooting an installed 
FiberPatrol system. The initial steps in addressing a system malfunction are:

• System inspection

• Connections check

• Controller reboot

• Processor reboot

• Documentation and reporting

Facility and Equipment Access 
Obtain permissions and means (keys, codes, etc.) to access the facility, security/equipment room, 
and equipment cabinet. 

System Inspection

Note the general conditions in the equipment room and rack enclosure, including:

• Ambient temperature

• Electrical power

• The state of any other equipment

• Network and Internet connectivity

Processor hardware check

Inspect the Processor unit and note the following:

• General state (ON/OFF)

• LED states (ON/OFF/Flashing)
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• Fan noise

• Beeping sounds

• Other noises

• Other abnormal indications

Processor interface check

Use the rack-mount keyboard, monitor and mouse to access the Processor. Document any of the 
following display conditions: 

• OFF (no video signal)

• ON, but blank

• Blue screen

• Frozen with a BIOS screen

• Frozen with a Windows screen

• Frozen with a FiberPatrol software screen

• BIOS error screen

• Windows error message

FiberPatrol software check

If the Processor (computer) is responsive, document any of the following conditions:

• Running or not running

• Frozen or responsive

• System Status (Armed, Cable Cut, Warning, or Disarmed)

• Head End alarms

• Status of System Check Points (on Event Logging panel)

Take a screen-shot of the signal response in the Sensor Signal graph on the Event Processing 
panel. Note any of the following conditions:

• Signal graph is blank

• Signal is a flat line at 0

• Signal line is fuzzy 

• Signal never goes below 0

• Signal never goes above 0

Controller Hardware Check

Inspect the Controller unit and note the following:

• LED states (ON/OFF/Flashing)

• Noises

• Other abnormal indications 

Cable connections check

Examine all cables and connections on the back panels of the Processor and Controller units. For 
each connection, verify:

• Processor to Controller connections are correct (no swapped data cables)

• Each connector is properly seated and fully plugged-in 

• Retaining screws are fastened and finger-tight
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• Each connector is secure (no wiggle room)

• Both ends of each cable are properly connected

• Cable has no visible damage

• Verify that the 68-pin SCSI connectors are correctly installed at both ends

• For each fiber optic connection, verify that the connector is not loose or over-tightened (the 
FC/APC connectors should be finger-tightened until snug)

• The fiber optic patch cables are connected according to the labels (1 through 4 or 1 through 6)

• Patch cables are routed loosely, without excessive bending, kinks, or crush points

• The connector keys are aligned (if not aligned, a connector will protrude more than the others)

Monitor any changes in the system status that occur while the connections are being verified. 

Controller reboot

When power cycling a Controller unit, allow at least 30 seconds in the OFF state.   

• Turn the unit Off using back panel power switch

• Wait a minimum of 30 seconds

• Turn the unit ON

• Allow approximately 2 minutes for the FiberPatrol Processor to detect and initialize the 
Controller

In the FiberPatrol IDS software, under the Configure menu select Reset Hardware. 

Verify the System Status following the Controller reboot.

Processor Reboot

Use the following sequence to reboot the Processor:

• Shut down the FiberPatrol IDS software via the Exit function (under the System menu)

• Reboot the computer via the Windows Restart function

• Allow the Processor to completely initialize

• Allow FiberPatrol IDS software to completely initialize

Verify the System Status following the Processor reboot.

Malfunction Reporting
Save the following items from the Processor hard drive to removable media:

• Any screen-shots

• The system configuration folder (C:\FiberPatrol\Configuration) 

• The system log folder (C:\FiberPatrol\Log)

Note If the Processor (computer) is unresponsive, reboot the Processor by 
turning the power switch OFF, waiting at least 30 seconds, and then 
turning the power switch back ON.

Note DO NOT interrupt the computer booting process with another hard 
reboot, or equipment damage may occur. 
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Archive these files and attach them to the electronic problem report that is being submitted to the 
Technical Service department. When compiling the report, include the following information:

• How the problem was discovered

• The immediate indications of the problem

• The steps taken to diagnose and solve the problem

• The results of the remedial actions

• Any observation made while following the system check procedures

• The final state of the system

• Any other notes concerning the problem

• The name, company, and contact information of the person providing the technical service

• The facility’s name and address

• The facility’s owner, or manager, or contact person, and their contact information

• The FiberPatrol sensor unit’s model number, software version and serial numbers

• The date and time of the service 

• The amount of service time 



FiberPatrol IDS Software Guide Page 53

4 Operator’s functions

FiberPatrol Definitions

Term Definition

Disturbance Disturbance is a detected and localized mechanical motion or vibration in the 
protected area.

Event When the total amount of disturbance within the specified limits of location and 
time exceeds the event threshold, the disturbance is declared to be an event.

In Progress An event remains in progress as long as the disturbance continues within a 
specified distance of the event location. The attributes of the event, including 
the event location, may be updated while the event is in progress. There may be 
more than one event in progress at different locations at the same time.

Complete An event expires and becomes complete if the disturbance stops for a period 
longer than the event life time. If the disturbance resumes at the same location, 
it may be declared a new event.

Alarm An alarm is a notification of an event, either in progress or complete. An alarm is 
generated for each event, once the event is declared (one event = one alarm).

Time of Alarm The date and time the alarm was generated. The alarm time may differ from the 
time the disturbance began.

Current Alarms An alarm remains current and is reported until the alarm is acknowledged or the 
system is disarmed. (The event may be in progress or complete.)

Clear Alarm
(Acknowledge)

An alarm is cleared (acknowledged) by an operator’s action. The operator must 
perform all actions defined by the facility’s alarm handling procedures before 
clearing the alarm. A cleared alarm is removed from the current alarms list and 
is no longer reported. If the event remains in progress, it can generate a new 
alarm, which will then be reported.

Event Location The average location of the disturbance which caused the event. The event 
location is refined while the event is in progress.

Event Duration The length of time between the beginning and the end of the disturbance.

Event Level The cumulative amount of disturbance over the event duration.
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Auto-start routine
• When the electrical power is turned on or restored, the FiberPatrol system will automatically 

power up.

• The FiberPatrol sensor unit auto-boots into a Windows administrator account.

• After a one-minute delay for the initialization process to complete, the FiberPatrol IDS main 
panel opens, with the FiberPatrol login window displayed.

• If login information is not entered within one minute, the FiberPatrol IDS will start at the 
Operator access level with the user name “LocalOperator”. 

Manual Windows login

The FiberPatrol system can be configured for manual startup. In this case, the Operator/
Supervisor has to login to Windows with a User Name and Password. The Windows user accounts 
are controlled by the system Supervisor. 

Starting the FiberPatrol software

Double-click the Launch FiberPatrol shortcut icon on the desktop.
OR
Select start\programs\FiberPatrol\Launch FiberPatrol.exe.

The default location of the FiberPatrol software is: 

C:\FiberPatrol\FiberPatrol.exe

Enter your user name and password, select your access level, and then select OK.

Once you have entered a valid password for the selected access level, the FiberPatrol software 
will proceed with the initialization sequence. If an incorrect password was entered or the Cancel 
button was selected, the program will shut down. Once the initialization sequence is completed, 
the system is armed.

The Operator access level is used for routine operation and for monitoring perimeter activity. The 
Operator level provides access to the Alarms and Alarm History panels, and partial access to the 
System menu. 

The Supervisor access level is required for adjusting system parameters and settings, changing 
passwords, accessing the FiberPatrol log files, and for shutting down the system. The Supervisor 
level provides access to the Alarms, Alarm History, Log and Signal sub-panels, and partial access 
to all menus.

Figure 55 FiberPatrol login window

Enter Username (not required)

Enter Password

Select the level of access
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The Installer access level enables the system installer or a maintenance technician to configure 
the FiberPatrol system, to diagnose the system operation, to optimize the hardware and software 
performance of the FiberPatrol sensor, and for shutting down the system. The Installer level 
provides access to the Alarms, Alarm History, Log, Signal and System sub-panels, and access to 
all menus.

The Factory Service access level is not available.

FiberPatrol Operator Control Panel 

The FiberPatrol Operator Control Panel provides access to the Alarms and the Alarm History sub-
panels (see Figure 56). The Alarms Sub-Panel is the default display of the FiberPatrol Software 
Interface. It displays detailed attributes of current alarms and enables the Operator to process 
alarms via the Clear Alarm button. The menu bar at the top of the panel provides access to some 
functions. Menu items that are not available to the Operator access level are grayed out. Figure 57 
shows the FP1100X Operator Alarms panel with 2 alarms and Figure 58 shows the FP1400 
Operator Alarms panel with 2 alarms. 

Status Panel

The Status Panel at the bottom of the Window contains three fields that are common to all sub-
panels - System Status, Alarm Status, and Alarm Location. The System Status field displays 
Armed to indicate the system is operating properly. The Alarm Status field indicates any current 
alarms. The Alarm Location field displays the location of the current alarm.  

Note The FP1400 sub-panels include Zone details rather than Location 
information. 

Figure 56 Operator Control panel (no alarms)

Menu bar

Sub-panel tabs

Clear Alarm button

Perimeter map display

Alarm data display field

Status Panel
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System Status

The System Status field displays information on the current state of the FiberPatrol system.

The System Status messages include:

• Initializing (steady) Is displayed at system start-up. During the initialization period the system 
is inactive. 

• Armed (steady) is the normal operating state. The system is ready and is monitoring for 
intrusion events. 

• Cable Cut (steady) is displayed when the system detects that the sensor cable has been cut 
or damaged (S1 and S2). Intrusion detection capability may be lost over a portion of the 
perimeter.

• Warning (flashing) The system is functioning in a distressed operating state. System 
operation is compromised; however, the intrusion detection ability is retained. 

• Disarmed (flashing) System operation is severely compromised and the intrusion detection 
capability is lost.

Figure 57 FP1100X series Operator Alarms panel (2 alarms)

Figure 58 FP1400 series Operator Alarms panel (2 alarms)

System Status, Alarm Status,
and Alarm Location fields

Alarm data for current alarms

Perimeter map alarm display
(2 alarms) 

(location-based alarm reporting)

System Status, Alarm Status,
and Alarm Location fields

Alarm data for current alarms

Perimeter map alarm display
(2 alarms) 

(zone-based alarm reporting)
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Alarm Status field

The Alarm Status field displays the current number of alarms:

No Alarms (steady) There are no current alarms.

Alarm 2 of 2 (steady) There are 2 current alarms, and the second alarm is selected.

Alarm 1 of 3 (flashing) There are 3 current alarms at least one of which is in progress, and the first 
alarm is selected.

Alarm Location field

The Alarm Location field displays the location of the currently selected alarm. If there are no 
current alarms, the Alarm Location displays None. By default, the Alarm Locations are based on 
the location of the event according to the length of the sensor cable. The software can be 
configured to display the name/number of the Zone and the GPS coordinates in the Alarm 
Location field. 

Menu bar
The Menu bar provides access to the system functions, based on the access level of the current 
user. Menus and menu items that are not available to the current user are grayed out. For the 
Operator, some of the functions on the Systems menu and Help menu are available.

The following is a summary of the FiberPatrol Operator menu items:

System menu

Login - displays the login window, used to change the access level while the system is running

Print Window - prints a copy of the FiberPatrol screen

Exit - requires Supervisor or Installer access level to shut down the system

Help menu

About - displays information about this FiberPatrol system

Alarms Sub-Panel

Alarm List

The Alarm List includes all current alarms in reverse chronological order. The most recent alarm is 
displayed at the top of the list. New alarms are added to the top of the list as they are generated. 
Cleared alarms are removed from the list immediately. Uncleared alarms are removed from the list 

Figure 59 FiberPatrol Operator menus

Grayed out menus and menu items

System and Help menus available

are not available
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according to the system’s Alarm Auto Clearing settings. Alarms can be selected from the alarm list 
by selecting the corresponding line on the list. The selected alarm is highlighted, and its location is 
displayed on the Map and in the Status Panel Location field. To clear the currently selected alarm, 
select the Clear Alarm button or double-click the highlighted line in the Alarm Attributes field. 

Alarm Attributes

Each line of the Alarm List includes the details of the corresponding alarm, including a unique 
Alarm ID number, the Date and Time, the Duration, the Status (in progress or complete), the Level 
(signal strength), the Type, the Location, the Zone and the Coordinates, if applicable. 

Map Display

The Map Display is a static image of a map, a photo, or a schematic of the site, which includes an 
overlay of the protected perimeter. The locations of any current Alarms are displayed on the 
perimeter line. The location of the currently selected alarm or, the most recent alarm is displayed 
as an explosion (FP1100X) or a red and yellow zone line (FP1400). Other Alarms are displayed as 
red dots (FP1100X) or as red zone lines (FP1400).

Clear Alarm button

The Clear alarm button is used to acknowledge alarms. Selecting the Clear Alarm button displays 
the alarm dialog window (see Figure 61) for the currently selected alarm. The alarm dialog window 
is used to enter details about the selected alarm (i.e., the alarm cause and response).

Operator actions

1. Select an alarm by left-clicking the corresponding line in the Alarm List.
When a new alarm is generated, it is added to the top of the Alarm List and selected 
automatically.
The location of the alarm is displayed on the Map and in the Status Panel Location field.

2. Select the Clear Alarm button.
Refer to the facility’s alarm handling procedures for details on processing alarms.

3. Enter the appropriate details in the Alarm Dialog.

Figure 60 FP1100X Alarms Sub-panel
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4. Select the Clear Alarm button on the Alarm Dialog.

Alarm Dialog details

The Alarm Dialog includes: 

• The alarm details contained in the Alarm List.

• An Established Cause field used by the Operator to enter a description of the cause of the 
alarm.

• A field used by the Operator to describe the actions taken.

• A Clear Alarm button to clear the alarm. 
Once cleared, the alarm is removed from the Current Alarms list. 
Cleared alarms are accessible through the Log sub-panel (requires Supervisor access level). 
The time the alarm was cleared and the Operator’s comments are included in the Event Log.

• The Apply button saves the Operator’s comments and closes the Alarm Dialog without 
clearing the alarm. 
Additional comments can be added and the alarm can be cleared later.

• The Cancel button discards the Operator’s comments and closes the Alarm Dialog without 
clearing the alarm.

Once the alarm is cleared, the Alarm Dialog closes and the selected alarm is removed from the 
Current Alarms list and Map Display. The details of the cleared alarm are accessible through the 
Alarm Log on the Log sub-panel for the remainder of the day (until archived). The details of the 
cleared alarm remain accessible through the archived log files.

The Alarm Dialog window has a display time limit of five minutes. If the Alarm Dialog closes 
because the time limit is exceeded, any text entries will be retained but the alarm will not be 
cleared. 

Alarm History Sub-Panel
The Alarm History sub-panel provides an overview of the alarms that were generated over the 
24-hour period beginning last midnight (24-hour limit). All events are shown regardless of whether 
the corresponding alarms have been cleared. The events in progress are shown as red dots, the 
completed events are shown as yellow dots and current disturbances (not yet events) are shown 

Note If the Operator does not clear an alarm within 24-hours, the alarm is 
cleared automatically (at the default Alarm Auto Clearing setting).

Figure 61 FiberPatrol Alarm Dialog

selected alarm details
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Actions Taken
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as gray dots. The horizontal axis of the display graph is the location and the vertical axis is the 
time. The Alarm History sub-panel is provided for information purposes, there are no actions 
associated with this sub-panel. The Show Waterfall Graph button displays the disturbance signals 
in a different format. 

Note The FP1400 Alarm History sub-panel includes Zone details rather than 
Location information. 

Figure 62 Alarm History Sub-Panel
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5 Supervisor’s functions

The Supervisor functions enable the fine-tuning of system parameters and operation, password 
maintenance, as well as simulating alarms, system faults, and cable cuts. 

The details on the Alarms sub-panel and the Alarm History sub-panel are the same as the details 
provided in the Operator’s functions.

Log Sub-Panel

The Log sub-panel includes detailed information on the intrusion events and system activity that 
have occurred during the 24-hour period beginning last midnight (24-hour limit). The Alarm Log 
table contains the attributes of all alarms that have occurred since last midnight. New alarm entries 
are added at the top of the list as they occur. These entries are copied from the Alarm List on the 
Alarms sub-panel.

The Event Log list contains information on system events, including logins, system initialization 
reports, hardware performance notifications, alarm clearing activity, and operator text entries. The 
Event Log list also includes the System Checkpoints details (pass or fail). The alarm and event 
information is saved to the hard drive (archived) and cleared from the Log display at midnight, as 
well as each time the FiberPatrol sensor unit is shut down. The archived Log Files are permanent 
records and can be used for reviewing the FiberPatrol system activity beyond the current 24-hour 
time window. 

Note The FP1400 sub-panels include Zone details rather than Location 
information. 

Figure 63: FiberPatrol Supervisor access level display

sub-panel access tabs
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Clear All button available
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To add a text entry to the event log, select the Add Entry button.
An Event Log Entry dialog displays in which comments can be added to the Event Log (see Figure 
65:). To save the entered data, select Add Entry. For entries that are specific to an alarm, include 
the alarm reference number. Once saved, the entry cannot be modified. To close the Add Entry 
dialog without saving the comments select the Cancel button.  

The Signal sub-panel

The Signal sub-panel displays the detection parameter settings and includes three Data Displays 
that provide a graphical representation of the detected disturbances based on time or location 
(Disturbance, Count). The system supervisor can adjust the settings and view the results on the 
signal display graphs. Figure 66: shows the FP1100X Signal sub-panel.  

Note The FP1400 Log sub-panel does not include the Type, Latitude and 
Longitude columns. 

Figure 64: Log sub-panel

Figure 65: Event Log Entry dialog

Note Do not adjust the Filter Cutoffs without direct technical support.

Note The FP1400 Signal graphs display zone-based disturbance signals.

Event log details
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Alarm Log table
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Disturbance signal display graphs

The upper Disturbance graph displays the maximum received disturbance signal from the selected 
zone. Select a zone from the Display Zone dropdown and the disturbance signal from the selected 
zone is displayed on the graph.

The middle Disturbance graph displays the maximum disturbance level from the section of cable 
specified on the bottom graph over time. 

The Count graph indicates all instances of localized disturbances that exceed the Disturbance 
Threshold. A disturbance that cannot be localized is ignored. Each disturbance is indicated by 
bars that are placed at the disturbance’s locations. For the FP1100X system, the width of each bar 
corresponds to a 10 m (33 ft.) location range. For the FP1400, each bar represents an alarm zone. 
The height of each bar indicates the disturbance count within that location range. A disturbance 
that is not yet associated with an event is indicated by gray bars. When an alarm is generated, the 
corresponding disturbance bars change to red. Unassigned (gray) disturbance bars are discarded 
at the end of the Disturbance Life time setting. Event (red) disturbance bars are discarded once 
the corresponding event is completed, depending on the Event Life time settings.

The Detection Thresholds and Detection Window parameters on the Signal sub-panel set the 
conditions for alarm generation. 

Supervisor menus
The Supervisor access level provides access via the menu bars to various functions that enable 
system configuration and test.

Figure 66: Signal sub-panel

Figure 67: FiberPatrol Supervisor’s menu bar
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System menu

System > Login - Displays the Login Dialog that is used for changing the Access Level while the 
FiberPatrol software is running. If an incorrect password is entered or the Cancel button is 
selected, the software continues to run with the same Access Level. 

System > Export Log Files - Saves the contents of the system logs into Log Files and clears the 
system logs. 

System > Export Images - Saves an image (jpg) of the current window.

System > Export All Images - Saves images (jpg) from the current window.

System > Print Window - Prints an image of the current window via the Windows default printer.

System > Exit - Shuts down the FiberPatrol software (displays login dialog for password entry).

Manage menu

The Manage menu provides access to the Clear All Alarms, Zone Masking, Zone Definition, 
Change Password and Test Alarm functions.

Manage > Clear All Alarms - Clears all current alarms without displaying the Alarm Dialog. This 
function is available on the Alarms sub-panel as the Clear All button.

Manage > Zone Masking - see Zone Masking (Access) on page 66.

Manage > Zone Definition - see Zone Definition on page 65.

Manage > Change Password - see Password maintenance on page 67.

Manage > Test Alarm - The Test Alarm function is used to simulate an alarm. This function 
generates a simulated alarm at a random location, and is generally used for demonstration, 
personnel training and functionality verification. 

Configure menu

Configure > Save Configuration - Saves the current system settings into the configuration file. 

Configure > Load Configuration - Loads settings from the configuration files. Used for updating the 
FiberPatrol IDS after the configuration files have been externally modified or replaced. 

Configure > Alarm Auto clearing - see Alarm Auto Clearing Settings on page 67.

Configure > Remote Interface - see Remote Interface on page 68.

Configure > Hardware Interfaces - Hardware Interfaces is a legacy holdover from previous 
versions of FiberPatrol, and does not apply to the current system.

Configure > Reset Controller - Resets the connection to the light signal hardware.

Configure > Factory Configuration > Revert - Resets the system configuration to the original 
system settings when used at the Supervisor access level.

Configure > Factory Configuration > Update - Updates the Factory settings to the current system 
settings when used at the Installer access level.

Service menu

Service > Simulate Cut - Opens a dialog that enables various cable cut scenarios to be simulated 
for demonstration, personnel training, and functionality verification.

Note System settings that are available to the Supervisor access level are 
automatically saved to the configuration file.
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Service > Status - Opens a dialog that shows the current system status, also enables the 
simulation of various system failures for demonstration, personnel training, and functionality 
verification.

Service > Frequency Display - see Frequency Display on page 45

Service > Environment Compensation - see Environment Compensation on page 41

Service > Motion Rejection Parallel - see Motion Rejection – Parallel Settings on page 42

Service > Motion Rejection Perpendicular - see Motion Rejection – Perpendicular Settings on 
page 43

Service > Save Raw Data (requires Installer access) - see Save Raw Data on page 44

Service > Load Raw Data (requires Installer access) - see Load Raw Data on page 45

Supervisor functions

Zone Definition

The Zone Definition window displays a table of Zone assignments and properties (see Figure 68:).

1. Select Manage > Zone Definition.

2. Select a table cell to edit the Zone’s attributes. 

3. Right-click on a row to add/delete Zones. 

4. Save the Zone definition by selecting the Apply button.

• The Start Location and End Location define the location range (length) of the corresponding 
zone. 

• The Location value of -1000 is reserved for the Head End equipment. 

• Multiple table lines can be used to assign more than one location range to a zone. 

• The Zone Label and Zone Name are text strings which identify the zone. The Zone Label 
cannot include any spaces. 

• In the Zone Type column, the first digit identifies the sensor type (1 = fence mount). The 
second digit indicates if the zone is currently active (1), or masked (0). 
Zone Type does not apply to the Head End zone.

• The Low Freq and High Freq parameters in the Zone Definition window are the same as the 
Filter Cutoffs on the System sub-panel, The Filter Cutoffs are used to customize the sensor’s 
frequency response to the type and condition of the fence on which it is mounted. Correct 
adjustment of the Filters increases the signal to noise ratio and helps to screen out the 
ambient background noise that is always present.

Figure 68: FiberPatrol Zone Definition dialog
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The Low freq cutoff (high pass filter) is used to screen out low frequency vibrations such as the 
fence motion caused by wind and loose fence fabric. The High freq cutoff (low pass filter) is 
used to screen out high frequency vibrations that can be caused by nearby machinery. The 
default settings of the Filter Cutoffs are factory set to provide good detection on most types of 
fences. A value of -1 indicates that the global threshold applies to the zone. The Filter Cutoffs 
do not apply to the Head End zone.

• The Disturbance Threshold, Alarm Threshold, and Duration Threshold values define zone-
specific threshold settings used to make local sensitivity adjustments. A value of -1 indicates 
that the global threshold applies. These settings do not apply to the Head End zone.

• The Disturbance Life, Disturbance Mask, and Disturbance Range values define zone-specific 
event timing and location settings used to make local adjustments. A value of -1 indicates that 
the global setting applies to the zone. These settings do not apply to the Head End zone.

• The Display Mode parameter controls the visual annunciation of the alarms for a zone, 
including the appearance of the alarms on the site map, and the information shown in the 
Event Location indicator. The following table includes the Display Mode values and their 
meanings (a value of -1 indicates that the global setting applies):

Zone Masking (Access)

A Zone can be Masked to prevent alarms from being reported in that Zone.

1. Select Manage > Zone Masking.

2. Select the Zone that will be Masked.
(All Zones can be Masked by selecting De-Activate All).

Note  Do not adjust the Filter Cutoffs without direct technical support.

Site Map Display

Not displayed Point Alarm Zone Highlight Both

Location 
Display

Zone Name 4 5 6 7

Location
absolute/relative

8/24 9/25 10/26 11/27

GPS
decimal/deg.min.sec

9/96 33/97 34/98 35/99

Zone & Location 12/28 13/29 14/30 15/31

Zone & GPS 36/100 37/101 38/102 39/103

Figure 69: FiberPatrol Zone Masking
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3. Select De-Activate to Mask the selected Zone.
OR

4. Select Schedule to setup a Schedule for when the Zone will be Masked automatically by the 
system.

Password maintenance

The Change Password dialog enables the Supervisor to assign and change passwords for system 
users. There is one password available for each level of user access. 

1. Select Manage > Password Maintenance.

2. Select the Access Level for the User.

3. Enter the User’s Old Password.

4. Enter the New Password.

5. Re-enter the New Password.
A dialog displays indicating the password was changed successfully.

Alarm Auto Clearing Settings

This dialog enables the Supervisor to setup the Alarm Auto Clearing function. Select 
Configure > Alarm Auto Clearing to setup automatic alarm clearing (no operator action required). 
The default setting is for alarms to be cleared automatically after a 24 hour period. The length of 
time can be changed, and alarms can be auto-cleared when they are completed. The Allow Active 
Alarms to be Automatically Cleared checkbox enables the automatic alarm clearing of an alarm 
that is in progress after the Alarm Life Time expires (see Figure 71:).

1. Check the Automatically Clear Alarms After checkbox.

2. Specify the time period after which the Alarms will automatically clear.
OR
3. Check the Upon Completion checkbox for alarms to clear automatically when completed.

4. Apply the changes.

Figure 70: FiberPatrol Change Password dialog
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Remote Interface

Select Configure > Remote Interface to display the Remote Communications Interface dialog. This 
dialog provides access to the Remote Interface Controls. 

Figure 71: FiberPatrol Alarm Auto Clearing Settings

Figure 72: FiberPatrol Remote Communication Interface Settings
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a System component list

Component Part Number Description

FiberPatrol processor 
and controller

FP1100X-01 FiberPatrol sensor unit for fence mounted applications: 
up to 1.5 km (0.93 mi.) of cut-immune detection processing
up to 3 km (1.86 mi.) of non cut-immune detection processing

FiberPatrol processor 
and controller

FP1100X-03 FiberPatrol sensor unit for fence mounted applications: 
up to 3 km (1.86 mi.) of cut-immune detection processing
up to 6 km (3.73 mi.) of non cut-immune detection processing

FiberPatrol processor 
and controller

FP1100X-06 FiberPatrol sensor unit for fence mounted applications: 
up to 6 km (3.73 mi.) of cut-immune detection processing
up to 12 km (7.46 mi.) of non cut-immune detection processing

FiberPatrol processor 
and controller

FP1100X-09 FiberPatrol sensor unit for fence mounted applications: 
up to 9 km (5.6 mi.) of cut-immune detection processing
up to 18 km (11.18 mi.) of non cut-immune detection processing

FiberPatrol processor 
and controller

FP1100X-12 FiberPatrol sensor unit for fence mounted applications: 
up to 12 km (7.46 mi.) of cut-immune detection processing
up to 24 km (14.91 mi.) of non cut-immune detection processing

FiberPatrol processor 
and controller

FP1100X-16 FiberPatrol sensor unit for fence mounted applications: 
up to 16 km (9.94 mi.) of cut-immune detection processing
up to 32 km (19.88 mi.) of non cut-immune detection processing

FiberPatrol processor 
and controller

FP1100X-20 FiberPatrol sensor unit for fence mounted applications: 
up to 20 km (12.43 mi.) of cut-immune detection processing
up to 40 km (24.85 mi.) of non cut-immune detection processing

FiberPatrol processor 
and controller

FP1100X-25 FiberPatrol sensor unit for fence mounted applications: 
up to 25 km (15.53 mi.) of cut-immune detection processing
up to 50 km (31.07 mi.) of non cut-immune detection processing

FiberPatrol processor 
and controller

FP1400-08 FiberPatrol sensor unit for up to 2.5 km (1.55 mi.) of detection 
processing for fence mounted applications with 8 independent 
alarm zones 

FiberPatrol 4 zone add-
on

FP1400-EXP-04 4 zone expansion module increases the number of independent 
alarm zones by 4 
(FP1400-08 - max. 5 expansion modules for 28 alarm zones)
(software license addition must be ordered at time of purchase)

FiberPatrol processor 
and controller

FP1400-12 FiberPatrol sensor unit for up to 5 km (3.1 mi.) of detection 
processing for fence mounted applications with 12 independent 
alarm zones 

FiberPatrol 4 zone 
add-on

FP1400-EXP12-04 4 zone expansion module increases the number of independent 
alarm zones by 4 
(FP1400-12 - maximum 8 expansion modules for 44 alarm zones)
(software license addition must be ordered at time of purchase)
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rack-mount keyboard, 
monitor, mouse combo

GB0296-15 Rack-mount 15 in. LCD monitor with keyboard and mouse for 
maintenance access to FiberPatrol processor

rack-mount keyboard, 
monitor, mouse combo

GB0296-19 Rack-mount 19 in. LCD monitor with keyboard and mouse for 
maintenance access to FiberPatrol processor

rack-mount splice tray FPEM0400 1 RU splice tray for the equipment room fiber optic connections 
(contains start/end modules)

End module single FPMA0212 Single end module for terminating 1 fiber sensor

End module double FPMA0222 Double end module for terminating 2 fiber sensors

Start module double FPMA0221 Double start module for equipment room fiber optic connections

Start/End module 
double

FPMA0223 Double start/end module for equipment room fiber optic 
connections and terminations

outdoor splice enclosure GM0749-24 outdoor splice enclosure for up to 24 outdoor fusion splices

outdoor splice enclosure GM0749-48 outdoor splice enclosure for up to 48 outdoor fusion splices

splice consumables kit FPKT0200 Components required to make up to 24 fusion splices

single-mode fiber optic 
cable

FPSP0412 single-mode fiber optic lead/sensor cable for fence applications 
(12 fibers) in multiples of 100 m (328 ft.)

single-mode fiber optic 
cable

FPSP0424 single-mode fiber optic lead/sensor cable for fence applications 
(24 fibers) in multiples of 100 m (328 ft.)

single-mode fiber optic 
cable

FPSP0436 single-mode fiber optic lead/sensor cable for fence applications 
(36 fibers) in multiples of 100 m (328 ft.)

single-mode fiber optic 
cable

FPSP0448 single-mode fiber optic lead/sensor cable for fence applications 
(48 fibers) in multiples of 100 m (328 ft.)

buried vault GM0748 Buried vault for below ground splices and cable loops 100 x 75 
x 45 cm (39 x 30 x 18 in.)

cable ties, 
polypropylene

GH0916 Bag of 1000 UV resistant cable ties (for temporary usage)

cable ties, stainless 
steel

GH1080-08 Bag of 100 stainless steel cable ties 20 cm (8 in.) (requires 
installation tool)

cable ties, stainless 
steel

GH1080-08C Bag of 100 coated stainless steel cable ties 20 cm (8 in.) (requires 
installation tool)

cable ties, stainless 
steel

GH1080-14 Bag of 100 stainless steel cable ties 26 cm (14 in.) (requires 
installation tool)

cable ties, stainless 
steel

GH1080-14C Bag of 100 coated stainless steel cable ties 26 cm (14 in.) (requires 
installation tool)

cable ties, stainless 
steel

GH1080-20 Bag of 100 stainless steel cable ties 51 cm (20 in.) (requires 
installation tool)

cable ties, stainless 
steel

GH1080-20C Bag of 100 coated stainless steel cable ties 51 cm (20 in.) (requires 
installation tool)

cable tie tool GX0310 cable tie installation tool for stainless steel cable ties

cable tie tool GX0311 deluxe cable tie installation tool for stainless steel cable ties

gate protection split 
conduit

FPKT0500 Split conduit 1 m (3.3 ft.) section and two gear clamps for sensor 
cable installation at protected swinging gates

FiberPatrol connector 
cleaning tool kit

GX0313 fiber technician connector cleaning kit for FiberPatrol applications

FiberPatrol installation 
tool kit

GX0314 fiber technician tool kit customized for FiberPatrol applications

Contact FiberPatrol for information on ordering FiberPatrol sub-assemblies.

Component Part Number Description
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b Specifications
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Sensor unit part number
(Sensor unit includes 
FiberPatrol processor & 
controller)

• FP1100X-01 - up to 1.5 km (0.93 mi.) of cut-immune fence detection
- up to 3 km (1.86 mi.) of non cut-immune fence detection

• FP1100X-03 - up to 3 km (1.86 mi.) of cut-immune fence detection
- up to 6 km (3.73 mi.) of non cut-immune fence detection

• FP1100X-06 - up to 6 km (3.73 mi.) of cut-immune fence detection
- up to 12 km (7.46 mi.) of non cut-immune fence detection

• FP1100X-09 - up to 9 km (5.6 mi.) of cut-immune fence detection
- up to 18 km (11.18 mi.) of non cut-immune fence detection

• FP1100X-12 - up to 12 km (7.46 mi.) of cut-immune fence detection
- up to 24 km (14.91 mi.) of non cut-immune fence detection

• FP1100X-16 - up to 16 km (9.94 mi.) of cut-immune fence detection
- up to 32 km (19.88 mi.) of non cut-immune fence detection

• FP1100X-20 - up to 20 km (12.43 mi.) of cut-immune fence detection
- up to 40 km (24.85 mi.) of non cut-immune fence detection

• FP1100X-25 - up to 25 km (14.91 mi.) of cut-immune fence detection
- up to 50 km (31.07 mi.) of non cut-immune fence detection

• FP1400-08 - up to 2.5 km (1.55 mi.) of fence detection
• FP1400-12 - up to 5 km (3.1 mi.) of fence detection

Power • 3 separate AC circuits, 100 - 240 V, 50/60 Hz
4th circuit required for keyboard/monitor/mouse (if applicable)

• 250 W max. (not including optional keyboard/monitor/mouse)

Mounting • EIA-19 in equipment rack with 51 cm (20 in.) mount depth, 5 cm 
(2 in.) front space and 15 cm (6 in.) rear space

• 9 RU contiguous rack space, min. 30 cm (12 in.) above floor
4 RU - processor 17.8 cm (7 in.)
3 RU - controller 13.4 cm (5.25 in.)
1 RU - fiber patch panel 4.5 cm (1.75 in.)
1 RU - keyboard/monitor/mouse 4.5 cm (1.75 in.)

Environmental • temperature - 10 to 35º C (50 to 95º F)
• humidity - 20 to 80% non-condensing

Weight • processor: 22.25 kg (49 lb)
• controller: 12.25 kg (27 lb)
• rack-mount enclosure: 5 kg (11 lb)
• keyboard/monitor/mouse: 10.5 kg (23 lb)
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Target resolution • 45 m (150 ft.) for simultaneous alarms - simultaneous alarms within 
45 m will be reported as one alarm; simultaneous alarms separated 
by more than 45 m will be reported as individual alarms

location accuracy • ± 4 m (13 ft.) in a quiet environment

Virtual alarm zones • maximum 1440 software defined alarm zones per sensor

Cable cut • reported and located to within 30 m (100 ft.)
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Target resolution • 1 target per zone for simultaneous alarms 

Virtual alarm zones (software 
configured)

• 1400-08 - 8 zones per system (expandable to 28 zones via 
FP1400-EXP-04 expansion modules)

• 1400-12 - 12 zones per system (expandable to 44 zones via 
FP1400-EXP120-04 expansion modules)

• minimum zone length - 15 m (50 ft.)

Cable cut • reported and located to specific alarm zone
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Sensor cable part number • FPSP04XX (XX = no. of fibers: 12, 24, 36, 48)

Max. length per reel • FP1100X Series 12 km (7.5 mi) typical
• FP1400-08 2.5 km (1.55 mi.)
• FP1400-12 5 km (3.1 mi.)

Fiber count • optional number of fibers: 12, 24, 36, 48 (2 required as sensor fibers, 
remaining dark fibers available for perimeter applications)

Fiber type/wavelength • single-mode; 1550 nm

Bend radius (smallest 
allowable)

• dynamic (during installation) - 25 cm (10 in.)
• static (during operation) - 15 cm (6 in.)

Tensile rating • during installation - 2700 N (600 lbf)

Outside diameter/weight • 11.1 mm (0.44 in.); 93 kg/km (62 lb/kft)

Optical power loss • max. allowable loss 0.3 dB/km (averaged over length of cable; 
OTDR measured form both ends of cable)

• max. cable attenuation - 0.25 dB/km @ 1550 nm
• max. loss per event (e.g., fusion splice) 0.1 dB
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Material/size/weight/length/
bend radius

• flexible innerduct - high density polyethylene
• OD 42.2 mm (1.66 in.); ID 35.3 mm (1.39 in.)
• wall thickness 3.12 mm (0.12 in.)
• 394 kg/km 265 (lb/kft)
• maximum continuous length 1829 m (6000 ft.)
• min. bend radius 46 cm (18 in.)
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Disturbance Threshold • the minimum level that a localized disturbance must reach to be 
accumulated and counted towards alarm generation, default = 5

Alarm Threshold • the minimum disturbance count that must accumulate in a location 
range and a time range in order to generate an alarm, default = 10

Duration Threshold • the minimum event duration (in seconds) required in order to declare 
an alarm, default = 0 (disabled)

Disturbance Life • the length of time, in seconds, for which any localized disturbance is 
retained, default = 15 s

Disturbance Mask • used to prevent a single disturbance event from being recorded as 
additional disturbances due to continuing reverberations caused by 
the initial disturbance, default = 0.3 s

Disturbance Range • defines the length of cable (or fence) over which a current 
disturbance event can be added to by additional disturbances in the 
same general area default = 6 m

Event Life • the length of time, in seconds, after which an event is complete, 
provided that no additional disturbance has occurred within the 
localized area of the event, default = 60 s

Environment Compensation • used to help screen out environmental factors like strong wind gusts 
and heavy precipitation that can cause nuisance alarms

• Spatial Environment Compensation monitors disturbance signals 
over a longer length of the sensing cable and removes common-
mode disturbance signals caused by environmental factors

• Temporal Environment Compensation works at a localized point of 
the sensor and removes background signals based on the point’s 
history over a time period

Parallel motion rejection • used to prevent nuisance alarms caused by nearby vehicles or trains 
moving alongside the sensor cable, and by planes taking off and 
landing alongside fences at airports

Perpendicular motion 
rejection

• used to prevent nuisance alarms caused by vehicles approaching 
the sensor cable directly, or passing through frequently used gates, 
and by planes passing over fences at airports
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c Location/calibration table

tap point # description time/location 1 time/location 2 time/location 3 avg. location
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tap point # description time/location 1 time/location 2 time/location 3 avg. location
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d Remote Alarm Output

Network Manager Alarm reporting Setup
In the default configuration, the FiberPatrol processor provides a TCP/IP server with one available 
connection for interfacing to a remote security management system (SMS). Additional connections 
can be configured (restrictions apply). 

• Transmission Protocol TCP

• Interface Mode Server

• Number of Connections 1 or more

• Default Port 4122

• Report Mode 0

• Data Formatting XML version 1.0

• XML Namespace Proprietary

• Text Encoding US-ASCII

Communication content

A standard FiberPatrol alarm report incorporates the following information:

• Device identification: site ID (internal), unit ID (internal), description (optional)

• System information: time stamp, system operational status

• Pre-alarm condition (optional)

• Alarm information: alarm ID (internal), time tamp, location (sensor location, GPS, and/or 
zone), event parameters (type, magnitude, duration, etc.)

• Alarm clearing notifications acknowledgements

The FiberPatrol remote communication interface accepts command messages that enable remote 
clients to perform the following operations:

• Clear alarms (by reference ID, by zone, clear all)

• Request alarm reports for expired alarms

• Query/modify basic detection settings

• Query/modify zone assignments, add/delete zones

• Query/modify zone-specific detection settings

Note Each FiberPatrol Zone name must begin with an integer when used with 
the Network Manager. The available range of zones is 1 to 480.
e.g., (1:Zone1, 2:Zone2, 3:Zone3, etc.)
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• Modify interface parameters (enable/disable reporting, set reporting interval, select report 
mode)

Communication timing

By default, FiberPatrol alarm reports are transmitted approximately once per second. When a new 
alarm is generated, a report with the new alarm information is transmitted immediately. Alarm 
information is transmitted for as long as an alarm is active (typically, for the duration of an event 
plus 60 seconds). The reporting interval is adjustable. Continuous reporting can be disabled, in 
which case an alarm report must be requested by a query command.
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